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Preface

Scope of Manual

This guide is designed to assist you in getting started with the use of NightSim™. Night-
Sim is a real-time NightStar™ RT tool that provides a graphical user interface to the
frequency-based scheduler and performance monitor services.

Structure of Manual

This manual consists of five chapters, four appendixes, a glossary, and an index. A brief
description of the chapters and appendixesis presented as follows.

* Chapter 1 introduces you to the concepts and components of NightSim, a
real-time tool that is part of the NightStar™ devel opment environment.

* Chapter 2 provides an overview of the primary factors that need to be taken
into account prior to running NightSim on RedHawk Linux.

* Chapter 3 explains the procedures for beginning and ending a NightSim
session and explains how to get help.

* Chapter 4 describes the frequency-based scheduler and introduces the
components of NightSim’s Scheduler window.

* Chapter 5 describes the performance monitor and introduces the
components of NightSim’s Monitor window.

* Appendix A discussesthe NightStar License Manager (NSLM) and how to
obtain and install licenses. It also discusses approaches for dealing with a
firewall either on the system acting as the license server or on a system
hosting the NightStar RT tools.

* Appendix B describes the additional functionality and capabilities of the
NightStar RT tools when running Concurrent’s RedHawk kernel.

* Appendix C discusses the format of configuration files used by NightSim.

* Appendix D presents the configurable X resources, NightStar resources,
and widget hierarchy for NightSim.

The glossary contains definitions of technical terms that are important to understanding
the concepts presented in this book.

The index contains an alphabetical reference to key terms and concepts and numbers of
pages where they occur in the text.
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Syntax Notation

The following notation is used throughout this manual:

italic

list bold

list

L 1

Referenced Publications

Books, reference cards, and items that the user must specify appear
in italic type. Special terms may also appear in italics.

User input appearsin list bold type and must be entered exactly
as shown. Names of directories, files, commands, options and system
manual page references also appear in list bold type.

Operating system and program output such as prompts and messages
and listings of files and programs appear in 1ist type.

Brackets enclose command options and arguments that are optional.
You do not type the brackets if you choose to specify such options or
arguments

The following publications are referenced in this document:

0890514
0891082
0898004
0898008
0898008
0898395
0898398
0898465
0898515
0898537

NightBench User’s Guide

Real-Time Clock and Interrupt Module User’s Guide
RedHawk Linux™ User’s Guide

NightSar RT Installation Guide

NightSar RT Tutorial

NightView RT User’s Guide

NightTrace RT User’s Guide

NightProbe RT User’s Guide

NightTune RT User’s Guide

MAXAda for RedHawk Linux Reference Manual
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1
Overview

This chapter introduces you to the concepts and components of NightSim, a real-time tool
that is part of the NightStar devel opment environment. NightSim provides agraphical user
interface to the major functions associated with the frequency-based scheduler and the
performance monitor.

Overview of NightSim

NightSim allows you to perform the entire range of functions associated with frequency-
based scheduling. You can perform the major functions of configuring a scheduler,
setting up a timing source, scheduling programs, saving and restoring a scheduler
configuration, running a simulation, and viewing scheduling data. The principal features
of the frequency-based scheduler are described in the section that follows.

NightSim also allows you to perform the entire range of functions associated with the
performance monitor. You can perform the major functions of selecting a scheduler,
clearing existing performance monitor values, enabling and disabling performance
monitoring, including and excluding interrupt time, and viewing performance monitor
values. The principal features of the performance monitor are described in “Overview of
the Performance Monitor” (seep. 1-2).

In addition, NightSim supports the use of timing sources, including Distributed Interrupts
devices on the RCIM (Real-Time Clock and Interface Module) board. An addition capa-
bility is NightSim's ability to configure a frequency-based scheduler on any system in
your network, not just the NightSm host.

NightSim is also integrated with other NightStar tools. NightSim may be invoked directly
from the Tools menu of any NightStar RT tool, and NightSim provides access to every
other NightStar RT tool in the same way. NightSim also provides the ability to schedule
your programs under the control of the NightView™ Source-Level Debugger, making it
easy to gain control of scheduled programs in order to set breakpoints or monitorpoints
early on in the execution of the program, before it attaches to the frequency based sched-
uler.

NightSim’s graphical user interface is based on the X Window System™ and
OSF/Motif™,

Overview of the Frequency-Based Scheduler

The frequency-based scheduler, or FBS, is a task synchronization mechanism that allows
you to run processes at specified frequencies. Frequencies can be based on high-resolution
clocks, an external interrupt source, or completion of a cycle. The frequency-based

1-1



NightSm RT User’s Guide

scheduler provides a mechanism for initiating processes at the specified frequency. The
processes are then scheduled via the standard priority-based scheduler.

When used in conjunction with the performance monitor, the FBS can be used to
determine the best way of allocating processors to various tasks for a particular
application. Chapter 4, “Using the Scheduler Window,” fully describes the features and
capabilities of the frequency-based scheduler.

Overview of the Performance Monitor

The performance monitor is a mechanism that allows you to monitor use of the CPU by
processes that are scheduled on a frequency-based scheduler. The values obtained can help
in determining whether processes need to be redistributed among processors for improved
load balancing and processing efficiency. You can obtain performance monitor values by
process or processor and can specify whether time spent servicing interrupts should be
included or excluded from the values. The performance monitor also makes it possible to
monitor a processor’s idle time. By examining the amount of idle time on each processor,
you can identify the processors that have the lightest load and determine the additional
amount of CPU time that can be used for scheduling real-time processes. Chapter 5,
“Using the Monitor Window,” fully describes the features and capabilities of the perfor-
mance monitor.

Overview of the Graphical User Interface

NightSim’s graphical user interface has two major windows:. the Scheduler window and
the Monitor window. The Scheduler window provides access to the key operations associ-
ated with frequency-based scheduling. The Monitor window provides access to the key
operations associated with performance monitoring. An overview of each window is pro-
vided in the sections that follow.

The Scheduler Window

1-2

Figure 1-1 presents the Scheduler window. This window allows you to configure a
frequency-based scheduler; set up atiming source for it; schedule programs on it; start,
stop, and resume a simulation; and view scheduling data.
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Figure 1-1. Scheduler Window

The Scheduler window also alows you to save a scheduler configuration to afile and to
open and save a configuration file that you have previously created. It shows whether the
window is active (associated with a scheduler that exists on the system) or inactive (not
associated with a scheduler that exists on the system) and whether the selected scheduler
is running or stopped. It displays the current minor cycle and current major frame for the
simulation, and it graphically shows the execution cycle for each process that is scheduled
on the scheduler.

Chapter 4, “Using the Scheduler Window,” provides a detailed explanation of each area of
the Scheduler window and provides reference information for all of the fields and controls
in each area.

The Monitor Window

Figure 1-2 presents the Monitor window. This window allows you to monitor the
performance of selected FBS-scheduled processes scheduled on one or more processors
on a selected scheduler. It allows you to display performance monitor values for selected
FBS-scheduled processes, clear performance monitor values for all FBS-scheduled
processes scheduled on one or more CPUs, and specify whether or not time spent servic-
ing interruptsis to be included in performance monitor timing values.
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Figure 1-2. Monitor Window

The Monitor window also allows you to specify whether performance monitoring
information isto be displayed in the Monitor window or written to a selected file. In either
case, you may specify the types of information that are to be reported, the resolution with
which performance monitor timing values are displayed (for example, microseconds, tens
of microseconds, milliseconds), and the rate at which values are to be updated.

The Monitor window allows you to specify a frequency-based scheduler with which the
window isto be associated. It shows whether the scheduler is active or inactive, and it
shows whether the simulation is running or stopped. If the scheduler is active, it displays
the current major frame and current minor cycle for the simulation. The Monitor window
also shows performance monitor values for selected processes.

Chapter 5, “Using the Monitor Window,” provides a detailed explanation of each area of
the Monitor window and provides reference information for al of the fields and controls
in each area.

Overview of RCIM Support

1-4

NightSim supports the Real-Time Clock and Interrupt Module (RCIM). An RCIM is an
hardware modul e attached to atarget system which contains the following interrupt-gener-
ating devices:

* real-time clocks (RTCs)
* edgetriggered interrupts (ETIS)
¢ programmable interrupt generators (PIGs)
Any of these devices may be used as the timing source for an FBS.

RCIMs may be connected via RCIM cables such that interrupts from one RCIM may be
distributed to other systems in the RCIM chain.

Each interrupt device on an RCIM may be configured as an RCIM-distributed or normal
device. By default, each interrupt device is available for use on the attached target system.
If the interrupt device is configured as an RCIM-distributed device, interrupts are also dis-
tributed between target systems using the RCIM cable.
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NightSim provides full support for the creation, control, and performance monitoring of
schedulers distributed across multiple SBC's and/or target computers in an RCIM chain
utilizing an RCIM-distributed device.

For more information see the Real-Time Clock and Interrupt Module (RCIM) PCI Form
Factor User’s Guide (0898007).
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2
Establishing the NightSim Environment

This chapter provides an overview of the primary factors that need to be taken into
account prior to running NightSim. These include system configuration requirements and
user requirements.

Configuration Requirements

NightSim requires the Frequency Based Scheduler to be installed on the target sytsem.
The FBS comeswith the RedHawk Linux distribution.

Typically, the default installation of the FBS is sufficient for NightSim activities. Refer to
the RedHawk Frequency-Based Scheduler (FBS) User’s Guide (0898005) for more infor-
mation on FBS configuration.

NightSim schedulers that are driven by an interrupt source require an RCIM device; a
real-timeclock, anedge-triggeredinterrupt, or adistributedinterrupt source.

If you do not have an RCIM device, you can still use NightSim's end-of -process schedul-
ing capability to drive your simulation. See End of Processing Cycle scheduling on page
4-2 for more information.

User Requirements

To use NightSim, you must also ensure that certain user requirements related to remote
shell access, environment variables, and capabilities are met. These requirements are
described in the sections that follow.

Remote Shell Access

When you configure NightSim to run your scheduled process under an xterm(1),
NightSim will run the xterm command on the NightSim host if the target is accessible
from the host viarsh(1).

Alternatively, if the xterm command is available on the target system, it is not necessary
to enable rsh access, because NightSim will execute the xterm command on the target
system.

To enable the use of rsh((1), ensure that there exists alogin on the remote target with the
same username as on the NightSim host. In addition, the . rhosts file in that user's

2-1
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Capabilities

2-2

home directory on the target system must contain an entry for that username and the
NightSim host.

Your target system must also be properly configured to accept rsh command execution.
See your target system documentation for details on how to enable rsh accessto your tar-
get system.

See the rsh (1) man page for more details.

Some of the operations associated with the frequency-based scheduler and the perfor-
mance monitor require certain capabilities such as CAP_SYS NICE.

Linux provides ameansto grant otherwise unprivileged users the authority to perform cer-
tain privileged operations. The Pluggable Authentication Module (see
pam_capability(8)) isused to manage sets of capabilities, called roles, required for
various activities.

Linux systems should be configured with an fbscheduser role which provides the
CAP_SYS_NICE and CAP_DAC_OVERRIDE capabilities.

Edit /etc/security/capability.conf and definethe Fbscheduser role(if itis
not already defined) in the “ROLES’ section:

role fbscheduser CAP_SYS NICE CAP_DAC OVERRIDE

Additionally, for each NightSim user on the target system, add the following line at the
end of thefile:

user username fbscheduser
where username is the login name of the user.

If the user requires capabilities not defined in the Fbscheduser role, add a new role
which contains fbhscheduser and the additional capabilities needed, and substitute the
new role name for fbscheduser in the text above.

In addition to registering your login name in /etc/security/capability.conf,
certain files under the /etc/pam.d directory must also be configured to allow capabili-
tiesto be activated.

To activate capabilities, add the following line to the end of selected filesin /etc/pam.d
if itisnot already present:

session required pam capability.so

Thelist of files to modify is dependent on the list of methods that will be used to access
the system. The following table presents a recommended configuration that will grant
capabilities to users of the services most commonly employed in accessing a system.



Table 2-1. Recommended /etc/pam.d Configuration

Establishing the NightSim Environment

letc/pam.d File | Affected Services Comment
remote telnet Depending on your system, the remote file may
rlogin not exist. Do not create the remote file, but edit it
rsh (when used w/o a command) if itispresent.
login local login (e.g. console) *On some versions of Linux, the presence of the
telnet* remote file limits the scope of the login fileto
rlogin* local logins. In such cases, the other services listed
rsh* (when used w/o a command) here with login are then affected solely by the
remote configuration file.
rsh rsh (when used with a command) eg. rsh system name a.out
sshd ssh You must also edit Zetc/ssh/sshd_config
and ensure that the following lineis present:
UsePrivilegeSeparation no
gdm gnhome sessions
kde kde sessions

If you modify Zetc/pam.d/sshd or Zetc/ssh/sshd_config, you must resetart
the sshd service for the changes to take effect:

service sshd restart

In order for the above changes to take effect, the user must log off and log back onto the

target system.

NOTE

To verify that you have been granted capabilities, issue the

following command:

/usr/sbin/getpcaps $$

The output from that command will list the roles currently

gned to you.
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3
Getting Started

This chapter explains the procedures for beginning and ending a NightSim session. It also
explains how to get help and how to use accelerators.

Invoking NightSim

The NightSim tool is available on your system as /usr/bin/nsim.

The syntax for executing nsim is asfollows:

nsim[-help] [-version] [-offline] [-s [hosthame] , key] |key]]

[-m [hostname] , key] [key]] [-Xoption ...] [[-F] file...]

Options are described as follows:

-help

-version

-offline

This option allows you to display the usage information for Night-
Sim and then exit.

This option allows you to display the version and copyright informa-
tion for NightSim and then exit.

Create Scheduler windows initially in Off-Line mode. See
“On-Line/Off-Line Operation” on page 4-6 for more information.

-S [hostname] ,key] | key]

This option creates a Scheduler window. If the optional hostname is
present, it causes the window to be associated with an FBS that is
active on the designated system. If the hostname is not specified, the
Scheduler window will be associated with an FBS on the local sys-
tem where nsimisinvoked.

The optional key is an integer value that identifies the scheduler.

This option may be used more than once; a Scheduler window will
be created for each occurrence of the option.

—-m [hostname] ,key] | key]

This option creates a Monitor window. If the optional hostname is
present, it causes the window to be associated with an FBS that is
active on the designated system. If the hosthname is not specified, the
Monitor window will be associated with an FBS on the local system
where nsim isinvoked.

The optional key is an integer value that identifies the scheduler. |If

31
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-Xoption

[-f] file

the key parameter is omitted and a Scheduler window is specified
with amatching hostname, the Monitor window will adopt the key of
the corresponding Scheduler window, if present.

This option may be used more than once; a Monitor window will be
created for each occurrence of the option.

You may also specify any standard X Toolkit command-line option.
Such options include -bg color to set the color for the window back-
ground; -Fg color to set the color to use for text or graphics; and
—Xrm resourcestring to set selected resources. For a complete list of
these options, refer to the X(1) system manual page.

This option alows you to specify the name of a file that contains
configuration and scheduling data for a selected frequency-based
scheduler.

To save the configuration and scheduling data entered in a particular
Scheduler window to a file, select the Scheduler->Save
Config File As menu item from that Scheduler window.
Procedures are fully explained in “Save Config File As...” on page
4-17.

You may also use atext editor to create or modify a configuration
file, following the format as described in “Configuration Files’ on
page C-1.

When invoking NightSim, you may specify optionsin any order; you may specify the -,

-s, and —-m options more than once asillustrated by the following example:

nsim-s buzzard,4 -s papio,5-m papio,5-F config_File

In this case, NightSim opens two active scheduler windows — one associated with the
scheduler identified by key 4 on target buzzard and one associated with the scheduler
identified by key 5 on target papio — amonitor window associated with the scheduler
identified by key 5 on target papio, and an inactive scheduler window associated with
the scheduler identified in config_file.

You may also invoke NightSim without specifying any options. Doing so allows you to
display an inactive Scheduler window. An inactive Scheduler window is one that is not
associated with a scheduler that exists on the system.

The steps for invoking NightSim are as follows:

1. Loginto your system.

2. Ensure that the value of your DISPLAY variable is set to the name of your
X server (or use the —display command-line option to the NightSim
command). If using aremote target system, please ensure that your display
name is reachabl e from the target system as well as the GUI host.

3. Typensim and any desired options after the system command prompt, and
pressthe Enter key.



Getting Help

Getting Sarted

NightSim provides on-line help information through the Help menu which is accessible
via the menu bars in the Scheduler window (see “Introduction to the Scheduler Window”
on page 4-9) and Monitor window (see “Introduction to the Monitor Window” on page
5-6). Figure 3-1 presents this menu:

n Context

n YWindow

n Help

Mightsim User's Guide
Mightstar RT Tutorial
Bookshelf

n Yersian

Figure 3-1. Help Menu

The following describe the options on the Help menu:

On Context
Mnemonic: C

Gives context-sensitive help on the various menu options, dialogs, or other parts of
the user interface.

Help for aparticular item is obtained by first choosing this menu option, then click-
ing the mouse pointer on the object for which help is desired (the mouse pointer will
become a floating question mark when the On Context menu item is selected).

In addition, context-sensitive help may be obtained for the currently highlighted
option by pressing the F1 key. HyperHelp™, NightSim's online help system, will
open with the appropriate topic displayed.

On Window

Mnemonic: W

Displays help information for the current window.

On Help
Mnemonic: H

Displays help information about how to use HyperHelp™, NightSim’s online help
system.
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NightSim User’s Guide
Mnemonic: U

Opens the online version of the NightSm RT User’s Guide in the HyperHelp viewer.

NightStar RT Tutorial
Mnemonic: S

Opens a HyperHelp window containing a tutorial which demonstrates the features
of NightSim™, NightProbe™, NightView™, NightTrace™, and NightTune™ in
one cohesive example.

Bookshelf

Mnemonic: B

Opens aHyperHelp window that listsall of the currently available HyperHelp publi-
cations.

On Version
Mnemonic: V
Displays a short description of the current version of NightSim.

In addition, context-sensitive help may be obtained for the currently highlighted
option by pressing the F1 key. The HyperHelp viewer will open with the appropri-
ate-ate topic displayed.

NightSim also provides help information through the Help buttons that appear in other
windows. When you click on the Help button in one of these windows, NightSim displays
the help information for that window.

Using Accelerators

A set of keyboard accelerators is defined for use within NightSim to provide quick access
to certain functions and menu items. Accelerators associated with menu items allow you
to access those items whether or not the menu is posted. Table 3-1 contains alist of the
accelerators and the resulting actions; where applicable, it indicates the menu items for
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which the accelerators provide shortcuts. Note that you can define additional accelerators
through the use of X resources (refer to the X(1) system manual page.

Table 3-1. Accelerators

Accelerator

Menu Item

Action

<Control> <W>

<Control> <Q>

<Control> <N>

<Control> <O>

<Control> <S>

F1

NightSim->Close Window

NightSim->Exit

Scheduler->New

Scheduler->Open Config File

Scheduler->Save Config File

Closes the current Scheduler or Monitor win-
dow

Exits NightSim

Clears all information from the current Sched-
uler window; resets the various areas to blank
or default values; and places the window in the
inactive state

In the current Scheduler window, opens a
scheduler configuration file that you have
previously saved

Saves the configuration and scheduling data
entered in the current Scheduler window in the
filethat is associated with the window

Displays context help for the component that
currently has the focus

Exiting NightSim

You may exit NightSim from the Scheduler or Monitor window by using one of the fol-

lowing techniques:

* Sdlect the NightSim->EXxit menu item.

* Press<Control> <Q>.

If you have not saved the changes that you have made in any window, you will be asked to

confirm that you wish to exit.
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4
Using the Scheduler Window

This chapter describes the frequency-based scheduler and explains how schedul er
frequency is defined and how processes are scheduled. It introduces the components of
NightSim’'s Scheduler window and describes the use of each component.

Understanding the Frequency-Based Scheduler

The frequency-based scheduler is atask synchronization mechanism that allows you to
run processes at frequencies that you specify. Frequencies can be based on high-resolution
clocks, an external interrupt source, or completion of a cycle. The frequency-based sched-
uler provides a mechanism for initiating processes at the specified frequency.

The frequency—based scheduler provides you with the ability to:

Define FBS frequency in terms of the duration of a minor cycle and the
number of minor cycles per major frame

Specify the scheduling parameters with which processes are scheduled
Detect frame overruns for all FBS-scheduled processes

View the status of FBS-scheduled processes

Remove one or all FBS—scheduled processes from a scheduler
Reschedule an FBS—scheduled process

Start, stop, and resume scheduling on a frequency—based schedul er

Connect a timing source to and disconnect it from a frequency—based
scheduler

Control use of the rea—time clock device as the timing source for a
frequency—based scheduler

Configure up to 100 frequency—based schedulers system—wide in a single
processor or multiprocessor environment

Use both frequency—based scheduling and static priority scheduling
simultaneously

In addition, NightSim provides the following additional capabilitiesfor your convenience:

Specify input and output files for scheduled processes
Specify aworking directory for scheduled processes.

Schedule processes under xterm(1) termina windows, providing the
option of interactive behavior
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¢ Schedule processes under the NightView debugger

NOTE

Some of these additional features are not available for schedulers
started via a saved script.

How Is Scheduler Frequency Defined?

You configure a frequency—based scheduler, in part, by defining the number of minor
cycles that compose a major frame. Minor cycles and major frames have associated with
them aduration of time that you can define by using atiming source for the scheduler. The
timing source can be the end of a minor cycle, areal—time clock, an edge-triggered inter-
rupt, or a user—supplied device.

If you use end-of-cycle scheduling, scheduling is triggered when the last process that is
scheduled during the current minor cycle of the current major frame compl etes its process-

ing.

If you use a real—time clock as the timing source, you can specify the period in microsec-
onds or the frequency in hertz.

How Are Processes Scheduled?

4-2

You schedule processes to run at a certain frequency by specifying the first minor cyclein
which the process is to be wakened in each major frame (called the starting base cycle)
and the frequency with which it isto be wakened (called the period).

If, for example, you schedule “ Process 1" with a starting base cycle of zero and a period of
two, the process will be wakened once every two minor cycles, starting with the first
minor cyclein the frame.

If you schedule “ Process 2" with a starting base cycle of one and aperiod of four, that pro-
cess will be wakened once every four minor cycles, starting with the second minor cycle
in the frame.

If you then schedule “ Process 3" with a starting base cycle of two and a period of two, that
process will be wakened once every two minor cycles, starting with the third minor cycle
in the frame.



Using the Scheduler Window

On a frequency—based scheduler configured with 100 minor cycles per major frame, these
processes will be wakened asillustrated in Table 4-1.

Table 4-1. Process Scheduling

Minor Cycle Processes Wakened

0 Process 1

1 Process 2

2 Process 1, Process 3
3

4 Process 1, Process 3
5 Process 2

97 Process 2

98 Process 1, Process 3
99

The maximum frequency with which you can schedule a process is once per minor cycle
(aperiod of one); the minimum frequency is once per major frame (in the case of the
example, aperiod of 100).

A process runs until it calls an FBS library routine that causes it to sleep until the
frequency—based scheduler wakes it again. The frequency—based scheduler wakes those
sleeping processes that are scheduled to be wakened in the current minor cycle of the
current major frame and repeats the process for each minor cycle in the current frame. It
continues to repeat the entire process on every major frame until the scheduler is disabled.
A scheduler configured with 100 minor cycles per major frame, a minor cycle duration of
10,000 microseconds (0.01 second), and a major frame duration of one second wakes
processes asillustrated in Table 4-2.

Table 4-2. Scheduler Operation

Major Frame  Time Minor Cycle Processes Wakened
(sec)

0 0 0 Process 1
0.01 1 Process 2
0.02 2 Process 1, Process 3
0.97 97 Process 2
0.98 98 Process 1, Process 3
0.99 99
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Table 4-2. Scheduler Operation (Cont.)

Major Frame Time Minor Cycle Processes Wakened
(sec)

1 1.00 0 Process 1
1.01 1 Process 2
1.02 2 Process 1, Process 3
1.97 97 Process 2
1.98 98 Process 1, Process 3
1.99 99

n n.00 0 Process 1
n.01 1 Process 2
n.02 2 Process 1, Process 3
n.97 97 Process 2
n.o8 98 Process 1, Process 3
n.99 99

Asillustrated in Table 4-2:

- When the current major frame is zero and the current minor cycle is zero,
the scheduler wakes “ Process 1.”

- After 0.01 second, it wakes “Process 2"; after 0.02 second, it wakes “Pro-
cess 1" and “Process 3”; and so on.

- At one second, when the current major frame becomes one, the current
minor cycle becomes zero again, and the scheduler wakes “ Process 1.”

- After .01 second, it wakes “Process 2.”
- After .02 second, it wakes “Process 1" and “Process 3”; and so on.

- The scheduler continues repeating this process for aslong asiit is enabled.

It is important to note that a process may not always run at the frequency that you have
specified. A frame overrun occurs when a scheduled process does not finish its processing
before it is scheduled to run again. Overrun counts are maintained for each process and for
each scheduler. You can obtain information on overruns by querying a processin the Mon-
itor window (see Chapter 5, “Using the Monitor Window”). When you schedule a process
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on a selected scheduler, you have the option of ensuring that the scheduler is stopped
when that process causes a frame overrun.

For additional information on the frequency-based scheduler, refer to the RedHawk Fre-
quency-Based Scheduler (FBS) User’s Guide (0898005).
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On-Line/Off-Line Operation

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line. You
can toggle the current state by pressing the On-Line/Off-Line button on either the
NightSim Scheduler window (see “On-Line/Off-Line” on page 4-21) or the Edit Pro-
cess dialog associated with it (see “On-Line/Off-Line” on page 4-30).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit Pro-
cess dialog can be avoided. When in Off-Line mode, the NightSim Scheduler will not
communicate with any servers on any timing host or target system of the Scheduler.

Thisis useful when creating a configuration for future use that deals with target systems
which may not currently exist or may not be currently accessible. The values entered in a
Scheduler whileit is Off-Line will be checked when the mode is changed to On-Line.

There are two ways to request atransition to On-Line mode:

1. Pressthe On-Line/Off-Line button on either the NightSim Scheduler or
its associated Edit Process dialog. Thistoggles the value on the face of
the button.

2. Pressthe Set Up button on the Scheduler window.

In each of these cases, when going from Off-Line to On-Line, theinformation entered in
the Scheduler window and its associated Edit Process dialog is examined for correct-
ness given the current state of the timing host and target systems. NightSim servers are
started if necessary, and all scheduled process attributes are checked for correctness.

If errors are found in the configuration, the user will be guided through the list of issues
discovered in the examination viathe Verify Scheduler dialog.

Verify Scheduler

46

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line (see
“On-Line/Off-Line Operation” on page 4-6). When going from Off-Line to On-Line,
the information entered in the Scheduler window and its associated Edit Process dialog
is examined for correctness given the current state of the timing host and target systems.

If errors are found in the configuration, the user will be guided through the list of issues
discovered in the examination viathe Verify Scheduler dialog. An example of such an
error is shown below.
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Scheduler verification failed.

Problem 1 of 1

=

Program /fang/jefh/testia.owt
Is not executable on target raptor.

B

| Remain Off-Line Help

Retry On-Line |

Figure 4-1. Verify Scheduler Dialog

The operation of the buttonsin the Verify Scheduler dialog is asfollows:

Retry On-Line

If all problems found during the current verification process have been attended to,
the user may press this button to re-attempt the transition to On-Line.

Previous Issue

Pressing this button will cycle to the previous issue found during the current verifi-
cation process. The text describing the problem will be displayed in the Verify
Scheduler diaog.

Next Issue

Pressing this button will cycle to the next issue found during the current verification
process. The text describing the problem will be displayed in the Verify Sched-
uler dialog.

Remain Off-Line

This button allows the user to continue to work off-linein lieu of the problems
found and attempt to transition to On-Line at alater time.

Help

This button displays appropriate information related to the problem currently dis-
played in the Verify Scheduler dialog.

For each issue, NightSim will highlight the label associated with the field most likely to be
of use in correcting the problem. If that field is on awindow that is not visible, NightSim
will raise the appropriate window to the top of the display. Below is a portion of the
NightSim Scheduler window corresponding to the error listed in Figure 4-1. Note that the
Timing host field is highlighted since the host name entered was invalid.
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Figure 4-2. Errors found during transition to on-line

After making the appropriate changes, the user may retry the transition to On-Line mode
or may chooseto remainin Off-Line mode. If new problems are discovered when transi-
tioning to On-Line mode, the Verify Scheduler window will re-appear.
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Introduction to the Scheduler Window

The Scheduler window allows you to configure a frequency-based scheduler; select atim-
ing source for it; schedule programs on it; start, stop, and resume a simulation; and view
scheduling data.

Figure 4-3 is an example of a Scheduler window.

E# | MightSim  Scheduler Tools

MightSim Host: nstar

Configuration file: {unnamed) &

Scheduler key: 2778 Timing host: |Erapt0r _| Scheduler Simulation Run Status

Cycles per frame: IE— Timing source  Real-time clock rc2 _|| @@ | Frame:

Max. tasks per cycle: IE_ Clock period: W Usec _|| () | Cycle:

Mex. tasks in schedule IE— =TT e ] nective Hemuag | On Target: Mo scheduler —

Permissions, w00 W Rate: Iﬁ.D—sec

g:;%:ntﬁ FID Program Hame CPU Bias ETES?‘ ERE? FParam Efrﬁt giiﬁ/ EEZI; Period SUElB Exeeutian Sehedul
A1
|

Figure 4-3. Scheduler Window

The Scheduler window consists of the following components:

* Menu Bar (see“Using the Scheduler Window Menu Bar” on page 4-11)

* On-Line/Off-Line Status Area (see “Using the On-Line/Off-Line Status
Ared’ on page 4-21)

* Configuration File Name Area (see “Using the Configuration File Name
Area’ on page 4-22)

¢ Scheduler Configuration Area (see “Using the Scheduler Configuration
Area’ on page 4-23)

* Process Scheduling Area (see “Using the Process Scheduling Area’ on
page 4-27)

* Scheduler Control Area (see “Using the Scheduler Control Ared’ on page
4-42)

* Simulation Control Area (see “Using the Simulation Control Area’ on
page 4-46)

* Run Status Area (see “Using the Run Status Area” on page 4-48)
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Procedures for using each component of the Scheduler window are described in the
sections that follow.

4-10
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Using the Scheduler Window Menu Bar

The Scheduler window menu bar is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Scheduler window menu bar provides access to the following menus:
* NightSim (see“NightSim” on page 4-12)
¢ Scheduler (see“Scheduler” on page 4-14)
* Tools (see“Tools’ on page 4-19)
* Help (see“Help” on page 4-20)

Each menu is described in the sections that follow.
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NightSim

The NightSim menu appears on the Scheduler window menu bar (see “ Using the Sched-

uler Window Menu Bar” on page 4-11).

The NightSim menu on the Scheduler window contains commands related to the global
operation of NightSim. Figure 4-4 presents this menu.

Create Scheduler Window

Create Monitar Window

Cuplicate Windaow

Close Window Ctrl+

Exit Ctrl+@Q

Figure 4-4. NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option alows you to create a new Scheduler window. The new window isinac-
tive—that is, it is not associated with a scheduler that exists on your system. Its text
fields contain blanks or default values. You may create any number of Scheduler
windows.

Create Monitor Window

This option allows you to create a new Monitor window. If the Scheduler window
from which you create the window is associated with an existing scheduler, the key
and target for that scheduler will be displayed in the Status Area of the new Monitor
window. In addition, if the scheduler is active, scheduled processes will be listed in
the Output Area of the new Monitor window. Use of the Monitor window is fully
explained in Chapter 5, “Using the Monitor Window.”

Duplicate Window

This option allows you to create a new Scheduler window with the same configura-
tion as that of the Scheduler window from which this option was selected.

Close Window

4-12

This option allows you to close the current Scheduler window. If the window is unti-
tled and contains unsaved changes, NightSim displays awarning dialog. If you pro-
ceed with the current action without saving, these changes will be lost. If you click
on the Yes button to save the changes, NightSim displays a file selection dialog. If
you click onthe No button, the changes will be discarded. If you click onthe Can-
cel button, the action is aborted.
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To select the file in which to save the changes, use the directory text area, file mask
area, list of directories, list of files, and file selection text area as appropriate. After
making a selection, you may save the changes to the selected file, search for another
file, cancel the operation, or display help related to the dialog.

If the Scheduler window is associated with a configuration file name and contains
unsaved changes, NightSim displays awarning dialog about saving changes. If you
proceed with the current action without saving, these changes will be lost. If you
click on the Yes hutton, the changes are saved in the file associated with the win-
dow. If you click on the No button, the changes will be discarded. If you click on
the Cancel button, the action is aborted.

If the window from which you select Close Window is the only window that you
have open, NightSim displays a confirmation dialog. You may confirm that you
wish to exit, continue to keep the window open, or display help related to the dialog.

This option alows you to exit NightSim. If you have open Scheduler windows that
are untitled and contain unsaved changes or if you have an active scheduler, Night-
Sim displays awarning dialog. In each case, you may save the changes, close the
window without saving the changes, cancel the close operation, or display help
related to the dialog. If you click on the Yes button to save the changes, NightSim
displays afile selection dialog.

If you have open a Scheduler window that is associated with a configuration file
name and contains unsaved changes, NightSim displays a warning dialog. If you
click on the Yes hutton, the changes are saved in the file associated with the win-
dow.

The warning dialogs are displayed for each window that contains unsaved changes.

4-13
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Scheduler

4-14

The Scheduler menu appears on the Scheduler window menu bar (see “Using the
Scheduler Window Menu Bar” on page 4-11).

The Scheduler menu contains commands that affect the current Scheduler window.
Figure 4-5 presents this menu.

[ew Ctrl+M
Select Active Scheduler..

T

Dave Script..

P
EAERRA N S R

Save Config File As..

Cirl+0

D

’d

ot
SRR

Pkl

. Do A
fryende Dgnoneriiot
RESTS AL S H I

Figure 4-5. Scheduler Menu

Descriptions of the options on the Scheduler menu follow.

New

This option allows you to clear al information from the current Scheduler window;
reset the various areas to blank or default values; and place the window in the inac-
tive state. The timing host is preserved, however.

If the window is untitled and contains unsaved changes, NightSim displays a warn-
ing dialog. You may save the changes, clear the window without saving the
changes, cancel the operation, or display help related to the dialog. If you click on
the Yes button to save the changes, NightSim displays afile selection dialog.

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays awarning dialog. You may save the changes, clear the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window.

NOTE

If the window containing the unsaved changes is associated with
an active scheduler, the scheduler will continue to run although
the window is no longer associated with it.
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Select Active Scheduler...

This option allows you to associate the current Scheduler window with a fre-
guency-based scheduler active on a given target system. When you select this
option, NightSim displays Figure 4-6.

If the window from which you select this option is untitled and contains unsaved
changes, NightSim displaysawarning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
thedialog. If you click onthe Yes button to save the changes, NightSim displays a
file selection dialog.

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window.

To assist you in selecting a scheduler, NightSim displays the selection dialog that
Figure 4-6 presents.

NOTE

NightSim needs to communicate with atarget system in order to
determine which schedulers are active. Thiswill occur even if the
existing Scheduler window is Off-Line. Thisisto be expected
since the existing scheduler will be abandoned when an active
scheduler is selected, and because an active scheduler is necessar-
ily On-Line (see“On-Line/Off-Line Operation” on page 4-6).

Target Eraptor

Key Owner Fermi=z=zion=
5 Jjeffh T == ==

Al
q root T —- - J
A

Scheduler Key: I
{3, | Cancell Help |

(. -

Figure 4-6. Select Active Scheduler Dialog

This dialog provides alist of the active schedulers for the system designated by the
Target field. The Target defaultsto your local host and the list contains the active
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schedulers running on that particular system. For instance, Figure 4-6 lists the two
schedulers currently running on the host amber2.

You may change the Target either by using the drop-down list or by typing the
name of the target systeminto the text field provided. Entering anitemin thisfield
will populate the list with the active schedulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may use the
Scheduler Key text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you select
from the list or enter a key, the selected scheduler must previously have been
configured, and you must have at least read permission for it; otherwise, NightSim
reports an error.

If you successfully select an existing scheduler, the Scheduler window becomes an
active window associated with that scheduler. Information related to the selected
scheduler replaces information that the window contained prior to the operation.

Open Config File...

This option allows you to open a scheduler configuration file that you have
previously saved. Thefileis opened in the current Scheduler window.

If the window from which you select this option is untitled and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button to save the changes, NightSim displays a
file selection dialog.

If the window is associated with a configuration file name and contains unsaved
changes, NightSim displays a warning dialog. You may save the changes, close the
window without saving the changes, cancel the operation, or display help related to
the dialog. If you click on the Yes button, the changes are saved in the file associ-
ated with the window.

To assist you in specifying a configuration file to be opened, NightSim displays a
file selection dialog. After making a selection, you may open the selected file,
search for another file, cancel the operation, or display help related to the dialog.
When you open the selected file, the Scheduler window is associated with that file
and displays the configuration and scheduling data contained in the file.

NightSim will open the configuration filein Off-Line mode. Once the file has been
read in, NightSim will make a transition to On-Line mode unless the -offline
option was used on the command line, or the *ofFl ine X resource was set to
True (see “X Resources’ on page D-1). When this transition occurs, the new
scheduler will be verified. See“On-Line/Off-Line Operation” on page 4-6 for more
information.

Save Config File

This option allows you to save the configuration and scheduling data entered in the
current Scheduler window in the file that is associated with the window. If the con-
figuration file name has not yet been specified, this option is disabled; you should
use the Save Config File As... option. See “Configuration Files’ on page C-1
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for a description of the format of this file as well as “Configuration File Example”
on page C-3 for an example.

Save Config File As...

This option allows you to specify the name of the file in which you wish the
configuration and scheduling data entered in the current Scheduler window to be
saved.

When you select this option, NightSim displays afile selection dialog. After making
a selection, you may save the current configuration and scheduling data in the
selected file, search for another file, cancel the operation, or display help related to
the dialog.

See “Configuration Files” on page C-1 for a description of the format of thisfile as
well as“ Configuration File Example’ on page C-3 for an example.

Save Script...

This option alows you to save the current configuration as a shell script containing
rtcp commands. The script may be run from any host in your network aslong asit
has rsh((1) accessto al the targets, as well as the timing host (see “Remote Shell
Access’ on page 2-1). This script can then be used to recreate your scheduler con-
figuration without the added overhead of NightSim, allowing your application to
start up and run more quickly. This can be extremely useful when dealing with
time-critical applications.

The main disadvantage of using this script instead of using NightSim is that you do
not get any monitoring capabilities. This may be less important for systemsthat are
typically used in production environments but can be critical to those systems used
in atesting/development environment where the monitoring feedback that NightSim
provides can be invaluable.

Another disadvantage is that the script does not support starting your processes
under NightView or xterm(1). For this features, you must use the NightSim
scheduler to start your scheduler.

If ascheduler which makes use of xterm or NightView is saved as a script, Night-
Sim will ignore these points and schedul e the processes directly. If File input or
output is used, NightSim will honor those filenames, but if the scheduler uses Stan-
dard Input Stream or Standard Output Stream, NightSim will forcibly redi-
rect from or to /dev/nul I in order to prevent rsh from hanging while waiting for
input or output.

See “Configuration Files” on page C-1 for details on this new format.

Set Clock Resolution...

This option allows you to select the resolution for areal-time clock that you have
selected as the timing source for a scheduler. The resolution indicates the duration in
microseconds of one clock count.

The duration of aminor cycle is defined by specifying the number of clock counts
per minor cycle (1 to 65,535) and the number of microseconds per clock count (1,
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10, 100, 1000, or 10,000). You determine the duration of amajor frame by multiply-
ing the duration of aminor cycle by the number of minor cycles per mgjor frame. If,
for example, you configure a scheduler with 100 minor cycles per mgjor frame and
you use as the timing source a real-time clock with a clock count of 10,000 and a
clock count duration of one microsecond, each minor cycle has aduration of 10,000
microseconds, or 0.01 second, and each frame a duration of one second.

When you select this option, NightSim displays the selection dialog that Figure 4-7
presents.

Select clock resolution;

10 — | us

0].4 Cancell Help |

= =J

Figure 4-7. Set Clock Resolution Dialog

You select the resolution by clicking on the toggle button and choosing one of the
following options: 1, 10, 100, 1000, or 10000. You may apply your selection,
cancel the operation, or display help related to the dialog.

The resolution of the clock affects the valid range of the clock period. See “Clock
period” on page 4-26.

Detailed Scheduler Info...

(Expert mode only)

The dialog associated with this option provides more information about the current
FBSwhich may be of interest to some users.

This option appears on the Scheduler menu (see “ Scheduler” on page 4-14) only
when the user is running in expert mode. See the expert resource under “X
Resources’ on page D-1 for more details.
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The Tools menu appears on the Scheduler window menu bar (see “Using the Scheduler
Window Menu Bar” on page 4-11) as well as on the Monitor window menu bar (see
“Using the Monitor Window Menu Bar” on page 5-7).

The Tools menu contains alist of other NightStar tools that can be launched directly from
NightSim.

MightBench Builder
MightProbe honitar
MightTrace Analyzer

MightTune Tuner

Mightiew Debugger

Figure 4-8. Tools Menu

Descriptions of the options on the Tools menu follow.

NightBench Builder
Opens the NightBench™ Program Development Environment.

NightBench is a set of graphical user interface (GUI) tools for developing software
with Concurrent's MAXAda™ compiler.

See the NightBench User’s Guide for more information.

NightProbe Monitor
Opens the NightProbe Data Monitoring application.

NightProbe is a real-time graphical tool for monitoring, recording, and altering pro-
gram data within one or more executing programs without significant intrusion.
NightProbe can be used in a development environment as atool for debugging, or in
a production environment to create a“control panel” for program input and output.

See the NightProbe RT User’s Guide for more information.

NightTrace Analyzer
Opens the NightTrace Analyzer.

The NightTrace Analyzer is a graphical tool for analyzing the dynamic behavior of
multiprocess and/or multiprocessor user applications and operating system activity.
NightTrace allows you to control user and kernel trace collection daemons and can
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graphically display the interplay between many real-time programs and processes
across multiple processors and systems.

See the NightTrace RT User’s Guide for more information.

NightTune Tuner
Opens the NightTune Performance Tuner.

NightTune is a graphical tool for analyzing the status of the system in terms of pro-
cesses, interrupts, context switches, interrupt CPU affinity, processor shielding and
hyperthreading control as well as network and disk activity. NightTune can adjust
the scheduling attributes of individual or groups of processes, including priority,
policy, and CPU affinity.

See the NightTune RT User’s Guide for more information.

NightView Debugger
Opens the NightView Source-Level Debugger.

NightView is a graphical source-level debugging and monitoring tool specifically
designed for real-time applications. NightView can monitor, debug, and patch mul-
tiple real-time processes running on multiple processors with minimal intrusion.

See the NightView RT User’s Guide for more information.

Help

The Help menu appears on the Scheduler window menu bar (see “Using the Scheduler
Window Menu Bar” on page 4-11) as well as on the Monitor window menu bar (see
“Using the Monitor Window Menu Bar” on page 5-7).

The Help menu provides access to the on-line help system. See “ Getting Help” on page
3-3 for detailed information about this menu and each of itsitems.
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Using the On-Line/Off-Line Status Area

The On-Line/Off-Line Status Areais a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The On-Line/Off-Line Status Area shows the name of the NightSim host as well as an

On-Line/Off-Line toggle button indicating the current state of operation of the Sched-
uler (see " On-Line/Off-Line Operation” on page 4-6).

MightSim Host: nstar

* On—Linel
Figure 4-9. Scheduler Window - On-Line/Off-Line Status Area

On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line and
Off-Line (see " On-Line/Off-Line Operation” on page 4-6). You can toggle the cur-
rent state by pressing the On-Line/Off-Line button on either the NightSim Sched-
uler window or its associated Edit Process dialog (see “Edit Process’ on page
4-29).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process dialog can be avoided. When in Off-Line mode, the NightSim Schedul er
will not communicate with any servers on any timing host or target system of the
Scheduler.

Thisisuseful when creating a configuration for future use that deals with target sys-

tems which may not currently exist or may not be currently accessible. The values
entered while Off-Line will be checked when the mode is changed to On-Line.
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Using the Configuration File Name Area

The Configuration File Name Areais a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Configuration File Name Area shows the name of the configuration file with which
the current Scheduler window is associated.

H Configuration file: /tutorialfsample-confiy & ||

Figure 4-10. Scheduler Window - Configuration File Name Area

If the window contains unsaved changes, the name is followed by awarning icon asillus-
trated by Figure 4-10. When the Scheduler window is not associated with a configuration
file name, the Configuration File Name Area displays (unnamed) asillustrated by
Figure 1-1 (seep. 1-3).
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Using the Scheduler Configuration Area

The Scheduler Configuration Areaisa part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-9).

The Scheduler Configuration Area allows you to configure a frequency-based scheduler,
select the timing source that is to be used for it, and specify the permissions that are to be
associated with it.

Scheduler key: [1000  Timing host: |Eiggy _|
Cycles per frame: IS— Timing source  Realtime clock i — |
hlex. tasks per cycle: IS— Clock period: IF usec — |
Ilex, tasks in schedule |5— fulliiEh kR
Permissions: BO0  rw e

Figure 4-11. Scheduler Window - Configuration Area

Descriptions of the text fields and controls contained in the Configuration Areafollow:

Scheduler key

Thisfield allows you to specify a key for the frequency—based scheduler that you
wish to create. The key is a user—chosen numeric identifier with which the scheduler
will be associated. It can be any positive integer value. Note that the number of
schedulers that can be configured at one time cannot exceed the value of FBSMNI,
which is the maximum number of frequency—based schedulers permitted on your
system (see Chapter 2, “Establishing the NightSim Environment,” for a description
of system tunable parameters).

Cycles per frame

Max.

Max.

Thisfield allows you to specify the number of cycles that compose a frame on the
specified scheduler.

tasks per cycle

This field allows you to specify the maximum number of processes that can be
scheduled to execute during one cycle.

tasks in scheduler

This field allows you to specify the maximum number of processes that can be
scheduled on the specified scheduler at one time. The number must be less than or
equal to the product that is obtained by multiplying the values specified in the
Cycles per frame and the Max. tasks per cycle text fields. Enter a number
ranging from one to the product of these values.
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Permissions

This field allows you to specify the permissions required for operations related to
the specified scheduler. Enter three octal digits—the first indicating permissions
granted to the owner, the second indicating those granted to the group, and the third
indicating those granted to other users. The octal method for setting permissions
associated with a scheduler is the same as that used for specifying mode with the
chmod command (for assistance in using this method, see the system manual page
for chmod (1)). The default, 600, grants read and alter (write) permission to the
owner only.

Timing host

Thisfield allows you to select the host of the timing source for the scheduler. You
may enter the name of the host directly in the entry field or choose from the supplied
list.

This list contains a list of possible timing hosts. NightSim maintains alist in
~/ _NightSimHosts of all hosts you ever used as a timing host. Once selected,
the Timing source menu is repopulated with the set of devices available on that
host.

Thisfield isempty by default. The user must providea Timing host name.

NOTE

The timing host cannot be changed while the scheduler is active;
you must first remove the scheduler.

Timing source
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This option menu allows you to select the timing source for the scheduler. The
timing source can be the end of aminor cycle, areal-time clock, an edge-triggered
interrupt, or a user-supplied device. Figure 4-12 presents an example of the option
menu.
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End of processing cycle

Feal-time clock rtcD
Feal-time clock rtc1
Feal-time clock rtcz
Feal-time clock rtc3

Edge-triggered Int. etil
Edge-triggered Int. eti1
Edge-triggered Int. etiz
Edge-triggered Int. eti3
Distributed Interrupt dio
Distributed Interrupt dit
Distributed Interrupt diz
Distributed Interrupt di3
Distributed Interrupt di4
Distributed Interrupt dis
Distributed Interrupt dis
Distributed Interrupt div
Cther...

Figure 4-12. Timing Source Option Menu

This list contains the set of devices available on the timing host. Note that the
options that NightSim displays vary according to the devices that are configured in
the system designated as the timing host and may change if the timing host is
changed. Thislist will be initially populated with the devices on the defaut timing
host.

If you select the End of processing cycle option from the Timing source
option menu, scheduling is triggered when the last process that is scheduled during
the current minor cycle of the current major frame completes its processing.

If you select areal-time clock, the Clock period text field is enabled so that you
can specify the information needed to set the clock.

If you select the Other...option, NightSim displays the dialog shown in
Figure 4-13. The text input areain this dialog alows you to specify the name of a
user-supplied device that you wish to use as the timing source. The Device Path-
name must be the name of a device file on the currently selected timing host and
that is supported by Concurrent’s RedHawk kernel as a FBS timing device. Cur-
rently, the only devices supported are those associated with an RCIM.

F Other Device [x]

Cevice Pathname:

9] | Cancell Helpl

Figure 4-13. Other Device Prompt Dialog
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Clock period

If you select areal-time clock as the timing source for the scheduler, this field
allows you to specify avaueto be used in setting the clock. Otherwise, thisfieldis
disabled.

You may specify the period in microseconds, milliseconds, hertz, or kilohertz by
clicking on the toggle button and choosing the desired option. Below the field isa
label that shows the minimum and maximum values that are permitted. The label
changes according to the option you choose. Figure 4-14 presents the options from
which you may choose.

Clock period; |E1DDDD usec il

{min=10, max=t MSEC
Hz
kHz

Figure 4-14. Clock Period Options

The valid range of the clock period is determined by multiplying the minimum and
maximum clock counts, 1 and 65535, by the clock resolution, which defaults to 10
microsends. By chainging the clock resolution, you can increase or decrease the
valid range of the clock period. See*” Set Clock Resolution...” on page 4-17 to adjust
the number of microseconds per clock count.
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Using the Process Scheduling Area

The Process Scheduling Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Process Scheduling Area allows you to:
- add programs to a frequency-based scheduler
- remove FBS-scheduled processes from a scheduler
- reschedule FBS-scheduled processes
- view scheduling data for current FBS-scheduled processes

- select the processes for which scheduling data are to be displayed.

Target Sched Prio- Soft Halts Start Cycle Execution Schedu.
Syztem PID Program Mame CPU Bias Pley, rity Param Lim, Owrn, Cycle Period @

raptor
raptor

Edit...

---=-  Afang/ jeffh test-/=im PR F 33 = 0 Mo o] 2 |® 4 e Al

Delete |

Filter... | Refgan | R

Figure 4-15. Scheduler Window - Process Scheduling Area

The Process Scheduling Area contains a scrolling list of the processes that are currently
scheduled on a frequency-based scheduler and the parameters with which they have been
scheduled (CPU mask, scheduling policy and priority, starting minor cycle, and so on).
You can select the process or processes that you wish to reschedule or delete by clicking
on the respective item(s) in thislist.

In addition, the Process Scheduling Areaincludes a grid that graphically shows the
execution cycle for each processin thelist. The labels at the top of the grid show the num-
ber of the minor cycle. The minor cycles in which each process is scheduled to run are
denoted by the appearance of the letter X in the appropriate column. You can use the hori-
zontal and vertical scroll barsto scroll the visible contents of the grid.

The Process Scheduling Area contains a row of process controls below the list of
FBS-scheduled processes. These controls are explained below:

Edit...

This push button allows you to add a program to a frequency-based scheduler or
reschedule an FBS-scheduled process. When you click on this button, NightSim dis-
playsthe Edit Process dialog (see “Edit Process’ on page 4-29). Note that if you
select a process from the list of scheduled processes and then click on this button,
the dialog contains the scheduling parameters for the selected process. NightSim
also displays the Edit Process dialog if you double click on aline in the list of
scheduled processes.

4-27



NightSm RT User’s Guide

Delete

This button allows you to delete FBS-scheduled processes from a scheduler. All
processes that are selected in the list will be deleted. When you click on this button,

NightSim displaysthe Delete Processes dialog (see “ Delete Processes’ on page
4-40).

Filter...

This button alows you to specify the FBS-scheduled processes that you wish to be
displayed in the Process Scheduling Area of the Scheduler window (see “Using the
Process Scheduling Area’ on page 4-27). When you click on this button, NightSim
displaysthe Filter Process List dialog (see“Filter Process List” on page 4-41).

Refresh
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This button is enabled only when the Scheduler window is active. Clicking on this
button updates the scheduler and process information in the window. If a process
terminates, for example, it will remain in the processlist until the Refresh buttonis
clicked, at which timeit will be removed.
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The Edit Process dialog allows you to add a program to a frequency-based scheduler or
reschedule an FBS-scheduled process. Notethat if you had selected a process from the list
of scheduled processes in the Process Scheduling Area (see “Using the Process Schedul-
ing Area’ on page 4-27) and then clicked on the Edit button, this dialog will contain the
scheduling parameters for the selected process. NightSim also displaysthe Edit Process
diaog if you doubleclick on alinein thelist of scheduled processes.

The Edit Process dialogis shown in Figure 4-16:

BID: (Mo process selected)

Target System: raptor

Working Directory: Ifapplication | Select...l

Process Mame: Itsk Select...l
Fis | Braeess | 1/0 and Debug

Parameter; I 2778 {optional)
Soft Qwrn. Limit: I 3

Chverrun: W Halt FBS on frame owerrun
Starting Cycle: I i} (0=lgwest, S4=highest)
Period: I 2 (0=unscheduled, 1=lowest, 55=highest)

;\«l Add | Reset Cancell Help |

Figure 4-16. Edit Process Dialog

The following fields appear at the top of the Edit Process dialog:

PID

This field specifies the unique frequency-based scheduler process identifier that is
obtained when a program is scheduled on a scheduler. When a program has not yet
been scheduled on the scheduler, thisfield displays“(Scheduler is inactive)”.

Target System

Thisitem indicates the target system on which this processis to be scheduled.
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On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line and
Off-Line (see “On-Line/Off-Line Operation” on page 4-6). You can toggle the cur-
rent state by pressing the On-Line/Off-Line button on either the the NightSim
Scheduler window or the Edit Process dialog associated with it (see “Using the
On-Lineg/Off-Line Status Area’ on page 4-21).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process dialog can be avoided. When in Off-Line mode, the NightSim Schedul er
will not communicate with any servers on any timing host or target system of the
Scheduler.

Thisis useful when creating a configuration for future use that deals with target sys-
tems which may not currently exist or may not be currently accessible. The values
entered while Off-Line will be checked when the mode is changed to On-Line.

Working Directory

You may specify the path to the working directory in which the scheduled process
will run. This path must be avalid directory name on the target system. If the target
system is not available, or if the Scheduler is Off-Line (see “On-Line/Off-Line
Operation” on page 4-6), the path must be avalid directory on the target system at
the time the program scheduler is created (i.e. when the Set up button is pressed on
the Scheduler window).

Select...

You may use the Select button to bring up the Select a Directory dialog
to specify the working directory for the program you want to configure under
the FBS.

Process Name
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This field specifies the name of the process that you wish to schedule. Enter afull
or relative pathname (see “Pathname Expansion” on page 4-39). The pathname
must be valid on the target system to which this process is assigned. If you have
selected a process from the list of FBS-scheduled processes prior to clicking on the
Edit button, this field contains the name of the FBS-scheduled process.

NOTE
You cannot change the name of a process while the processis run-
ning. You must either stop the scheduler first or add a new pro-
cess with the desired name.

Select...

You may usethe Select button to bring up the Select a Program diaog to
choose the program you want to configure under the FBS. Note that NightSim
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displaysfiles on the selected target systemif it is reachable viathe network. |If
the target system is unavailable, NightSim will disable file browsing on the
target system. In addition, the Scheduler must be operating in an On-Line
state in order to browse on the target file system (see “On-Line/Off-Line
Operation” on page 4-6).

The bottom portion of the Edit Process dialog is divided into a number of pages that
contain various parameters related to the given process. These pages are:

- FBS (see“FBS’ on page 4-32)
- Process (see“Process’ on page 4-35)
- 1/0 and Debug (see“1/O and Debug” on page 4-37)

NOTE

If the Process Name is/idle, then all of the fields which are
inappropriate for the /idle pseudo-processes are desensitized.
Only the CPU Bias field isvalid for /idle.

After you have entered the scheduling parameters for a specified program, you may apply
the changes and close the Edit Process dialog, apply the changes without closing the
dialog, add another program to the scheduler, reset the contents of the dialog to its initial
state, cancel the changes and close the dialog, or display help for the dialog.
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FBS

4-32

The FBS tab of the Edit Process dialog (see “Edit Process’ on page 4-29) allows the
user to specify parameters such as the starting cycle, period, and overrun limits for the
given process.

The FBS page of the Edit Process dialogis shown in Figure 4-17:

PID: (Mo process selected)

Target System: raptor

Working Directory: Ifapplication | Select...l

Process Mame: Itsk Select...l
Fis | Process | 1/0 and Debug

Parameter; I 2778 {optional)
Soft Qwrn. Limit: I 3

Chverrun: W Halt FBS on frame owerrun
Starting Cycle: I i} (0=lgwest, S4=highest)
Period: I 2 (0=unscheduled, 1=lowest, 55=highest)

i | ;\«l Add | Resetl Cancell Help |

Figure 4-17. Edit Process Dialog - FBS

Parameter

This field allows you to pass an integer value to a process that is scheduled on a
frequency—based scheduler. The value must be a 32-bit decimal value. The default is
no value. The process can retrieve this value by using the sched_fbsqry(3)
library routine.

Soft Ovrn. Limit

Thisfield allows you to specify a consecutive overrun limit count that this process
will tolerate and have processed as soft overruns by the kernel. Soft overruns are
catastrophic failures only if the process reaches its limit on the number of soft over-
runstolerated. This soft overrun limit defaultsto O for each process.
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Overrun

This check button allows you to indicate whether or not the selected scheduler
should be stopped in the event that the specified program causes a frame overrun.
Turn this button on if you wish the scheduler to be stopped.

NOTE

This may useful in conjunction with scheduling a process under
the NightView debugger, making it easier to stop a scheduled pro-
cess at the source of an overrun and determine the activity which
caused the overrun to occur.

Starting cycle

Thisfield allows you to specify the first minor cycle in which the specified program
isto be wakened in each major frame. Enter a number ranging from zero to the total
number of minor cycles per frame minus one. (The total number of minor cycles per
frame is defined when you use the Scheduler Configuration Areato configure a
scheduler. See*Using the Scheduler Configuration Area’ on page 4-23 for details.)

NightSim displays the range of starting cycle values that you can enter next to the
Starting cycle field.

NOTE

You must enter a starting cycle of zero for unscheduled processes
(for an explanation of unscheduled processes, see Chapter 5,
“Using the Monitor Window,” and the section entitled “Monitor-
ing Unscheduled Processes’).

Period

Thisfield allows you to establish the frequency with which the specified program is
to be wakened in each major frame. A period of one indicates that the specified
program isto be wakened every minor cycle; aperiod of two indicatesthat it isto be
wakened once every two minor cycles, a period of three once every three minor
cycles, and so on. Enter the number of minor cycles representing the frequency with
which you wish the program to be wakened. This number can range from zero to the
number of minor cyclesthat compose aframe on the scheduler. (The total number of
minor cycles per frame is defined when you use the Scheduler Configuration Area
to configure a scheduler. See “Using the Scheduler Configuration Area’ on page
4-23 for details.)

NightSim displays the range of period values that you can enter next to the Period
field.
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NOTE

You must enter a period of zero for unscheduled processes (for an
explanation of unscheduled processes, see Chapter 5, “Using the
Monitor Window,” and the section entitled “Monitoring Unsched-
uled Processes’).

NOTE

If the Period of aprocess is changed while the scheduler is run-
ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.
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Process

The Process tab of the Edit Process dialog (see “Edit Process’ on page 4-29) alows
the user to specify the CPU bias, scheduling policy, and priority of the given process.

The Process page of the Edit Process dialog is shown in Figure 4-18:

Edit Process - Key 5

fapplicatior;

Figure 4-18. Edit Process Dialog - Process

CPU Bias

This panel of check buttons allows you to select the processor or processors on
which the program can be scheduled. Click on one or more buttons, where the |abel
0 represents the first logical CPU, 1 represents the second, and so on. To select all
CPUs on your system, click on the All CPUs button.

NOTE
If the CPU Bias of aprocessis changed while the scheduler is

running, the Monitor window will not reflect the updated value
until the next Monitor window update after the processruns again.
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NOTE

You cannot change the CPU bias of Zidle while the scheduler is
active because it isnot areal process. You must either add a new
process with the desired CPU bias, or make the change while the
scheduler isinactive. See “How Is Idle Time Monitored?” on
page 5-3 for more information.

Sched Policy

This panel of radio buttons allows you to select the POSI X scheduling policy for the
specified program. The options are as follows: the FIFO (first—in—first—out)
scheduling policy, the Round Robin scheduling policy, and the Other (interac-
tive) scheduling policy.

Priority
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The range of priority values that you can enter is governed by the scheduling policy
specified. Y ou can determine the allowable range of priorities associated with each
policy (FIFO, Round-Robin, or Other) by invoking the run(1) command from the
shell and not specifying any options or arguments (see the corresponding system
manual page for an explanation of this command). Higher numerical values
correspond to more favorable scheduling priorities.

NightSim displays the range of priority values that you can enter next to the
Priority field.

NOTE
If the Priority of aprocessis changed while the scheduler is run-

ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.
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Thel/O and Debug tab of the Edit Process dialog (see “Edit Process’ on page 4-29)
allows the user to specify where to read input from, where to send output, and if the pro-
cessisto be scheduled within a NightView dialogue or within an xterm(1) window.

Thel/O and Debug page of the Edit Process diaogis shown in Figure 4-19:

PID: (Mo process selected)
Target System: raptor
Working Directory: Ifapplicatior{ Select...l
Process Mame: Itsk Select...l
FES | Process | 140 and Debug
Debug: W Schedule program within a NightView dialogue
# Terminal: I Schedule program within an xXterm window

Read Input From: ) File # Standard Input Stream

Send Output To: @ File ) Standard Qutput Stream

Cutput File: Iftmpa’log | Select...l

;\«l Add | Resetl Cancell Help |

Figure 4-19. Edit Process Dialog - I/O and Debug

Debug

Schedule this process under the NightView debugger. When the Schedule pro-
gram within a NightView dialogue checkbox is checked, the process will be
stopped at the point it begins execution, allowing early intervention for the purpose
of setting breakpoints, watchpoints, etc. A resume command to NightView is
required to resume the execution of the scheduled process.

NOTE

Scheduling processes under the FBS requires certain capabilites
(see " Capabilities’ on page 2-2). It isthe responsibiliy of the user
to ensure that appropriate capabili are granted to the NightView
session.
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X Terminal
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Schedule the processin an xterm(1) window. Anxtermwindow may beusedin
conjunction with scheduling the process under NightView as well, if so desired (see
Debug above). This permits the scheduled process to interact with the terminal
services provided by the xterm.

Read Input From

Select the input source, if any, for the scheduled process. By default, asin previous
versions of NightSim, input is taken from the file, /dev/null. When either the
Debug or X Terminal checkboxes are selected, the default is to permit input to
come from the Standard Input Stream, but you may choose File input in either
case if your scheduled program needs a fixed input stream (see Input File below).

Input File

If File isselected for Read Input From, thisfield specifies the name of the input
file which the scheduled process will use. By default, the fileis Zdev/null. See
“Pathname Expansion” on page 4-39.

If the NightSim Scheduler is On-Line (see “On-Line/Off-Line Operation” on page
4-6), the pathname given must be a valid file on the target system with sufficient
read permissions.

If the NightSim Scheduler is Off-Line, the path must represent avalid readable file
at the time the program scheduler is created (i.e. when the NightSim Scheduler tran-
sitionsto an On-Line mode of operation).

Select...

You may use the Select button to bring up the Select a File diaog to spec-
ify the name of the input file which the scheduled process will use.

Send Output To

Select the way to manage output from your scheduled process. If neither the
Debug and X Terminal checkboxes are selected, you may select File output,
where the default fileis Zdev/nul 1. Output may be sent to an actual file specified
in the Output File field, if desired. By default, output is sent to the Standard
Output Stream of the scheduled process.

Output File

If File isselected for Send Output To, thisfield specifies the name of the output
fileto generate. The output file name may be afull pathname or may be a pathname
relative to the Working Directory specified for the scheduled process. See “Path-
name Expansion” on page 4-39.
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Select...

Pathname Expansion

You may use the Select button to bring up the Select a File diaog to spec-
ify the name of the output file that will be generated.

When entering the Process Name, Input File, or Output File inthe Edit Process
dialog (see “Edit Process” on page 4-29), the user can make use of the following
conventions:

- if the pathname begins with /, it is assumed to be fully rooted

- if the pathname begins with ., . ., or asimple file or directory name, it is
assumed to be relative to the path in the Working Directory field

- if the pathname begins with ~, it is interpreted according to the values of
the following environment variables on the NightSm host:

~, ~/, or ~user (where user is the username of the user running
NightSim), the login directory of the user is substituted

~otheruser (where othername is a user other than the user running
NightSim), the login directory of otheruser is substituted

~+, the value of $PWD on the NightSim host is substituted.
~-, thevalue if $OLDPWD on the NightSim host is substituted

- if any part of the pathname contains an environment variable reference of
the form $name, the value of $name on the NightSim host is substituted

The pathnames will be expanded and substitutions made at the time the Apply or Add
button is pressed.
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Delete Processes
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The Delete Processes dialog is presented when deleting FBS-scheduled processes after
pressing the Delete button in the Process Scheduling Area (see “Using the Process
Scheduling Area’ on page 4-27).

If the scheduler is active when you click on this button, NightSim displays adialog to con-
firm killing the selected processes. You may press the Yes button to kill the selected pro-
cesses after deleting them from the frequency-based scheduler. You may also press the
No button to del ete the processes from the scheduler but allow them to continue executing
or press Cancel to abort the action.

If the scheduler is inactive when you click on this button, NightSim displays a dialog to
confirm deleting the processes. You may press OK to delete the processes from the sched-
uler or Cancel to cancel the operation.
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Filter Process List

TheFilter Process List dialog alows you to specify the FBS-scheduled processes that
you wish to be displayed in the the Process Scheduling Area (see “Using the Process
Scheduling Area” on page 4-27) of the Scheduler window. When you click on this button,
NightSim displays the dialog that Figure 4-20 presents.

Target FID Program Mame CFPU Eias Wizible
raptor = ----- AJapplicationsworkloadl All CPU=s Yes A
raptor = ----- AJapplicationsworkload2 All CPU=s Yes
raptor ----- Aidle @ococccccccccscsse Yes
raptor ----- Aidle ollocococoooooooooo Yes
£
PID Program Mame CPU hask
i i 01 2 3 45 6 7 8 9101112131415
I I i i ) o s o ] R S
Showl Hide | Closel Help |
I

Figure 4-20. Filter Process List Dialog

Filter Process List

Thislist contains al of the processes that are scheduled on the scheduler and indi-
cates whether or not they are visible in the list presented in the Process Scheduling
Area of the Scheduler window (see “Using the Process Scheduling Area” on page
4-27 for details). You may use the mouse to select the process or processes that you
wish to show or hide and then click on the Show or Hide button as desired.

You may also use a combination of the following items to specify which processes you
wish to show or hide:

FPID

You may specify the unique frequency-based scheduler process identifier for a pro-
cess that you wish to show or hide.

Program Name

You may specify the name of the process that you wish to show or hide. Enter afull
or relative pathname. The pathname must be valid on the target systemto which this
process is assigned.

CPU Mask

This panel of check buttons allows you to show or hide processes which are sched-
uled on the specified processor or processors. Click on one or more buttons, where
the label O represents the first logical CPU, 1 represents the second, and so on. To
select all CPUs on your system, click on the All button.
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If an FBS-scheduled process with the specified identifier(s) does not exist, NightSim
reports an error. If more than one FBS-scheduled process with the specified identifier(s)
exists, al such processes are shown or hidden.

Show

Listsin the Process Scheduling Area (see “ Using the Process Scheduling Area” on
page 4-27) of the Scheduler window those processes either selected in the Filter
Process List or specified using FPID, Program Name, or CPU Mask .

Hide

Removes from the Process Scheduling Area (see “Using the Process Scheduling
Area’ on page 4-27) of the Scheduler window those processes either selected in the
Filter Process List or specified using FPID, Program Name, or CPU Mask.

Using the Scheduler Control Area
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The Scheduler Control Areais a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Scheduler Control Area allows you to create and remove a frequency-based sched-
uler. It contains two push buttons that you use to perform these functions: the Set up but-
ton and the Remove button.

Zcheduler

Active

Figure 4-21. Scheduler Window - Scheduler Control Area
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The Scheduler Control Area also contains an icon that indicates the current state of the
Scheduler window.

When the window is inactive, NightSim shows an
unplugged connection.

When the window is active, it shows a plugged
connection.

Active

The Set up button is enabled only when the window is in the inactive state. When you
click onthe Set up button, NightSim carries out the following actions:

* Transitions the NightSim Scheduler to an On-Line mode of operation, if
the NightSim Scheduler is operating in an Off-Line mode (see
“On-Line/Off-Line Operation” on page 4-6). The state of the target on
which processes are scheduled, the existence and execute permissions of
each scheduled program, and the existence and read permissions for any
input files required.

* Determines whether there is an existing scheduler that is associated with
the same key as that entered in the current window.

If an active scheduler with the same scheduler key as the key you selected
already exists on the target systemto which you assigned processes, Night-
Sim displays the dialog that Figure 4-22 presents.

% An active scheduler with key 5 already exists on target raptor.

Zelect an action:

_) Abandon scheduler "Set up” and select the active scheduler

|ﬁ Remave the active scheduler and continue "Set up”

Handle active scheduled processes:
{# Remove from the active scheduler and kil

_JRemove

_Jkeep and add processes to the new scheduler

014 | Cancell Help |

Figure 4-22. Scheduler Exists Dialog
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You have two main choices:

- Work with the existing FBS, in which case the active FBS's configu-
ration will appear in the Scheduler window in place of the current
configuration.

or

- Replace the existing FBS with a new scheduler based on the configu-
ration in the window.

If you decide to replace the existing FBS, you then need to decide what to do
with the processes running under the old FBS.

You may also pressthe Cancel button to abort this action.

* Createsascheduler that is configured according to the parameters specified
in the Scheduler Configuration Area of the window (see “Using the Sched-
uler Configuration Area’ on page 4-23 for details)

* Schedules the processes that are listed in the Process Scheduling Area of
the window and starts them running (see “Using the Process Scheduling
Area’ on page 4-27 for details). Programswill run up to the first foswait
system call.

¢ Attaches the timing source to the scheduler

* Enablesthe Start button in the Simulation Control Area

Initially, the simulation is stopped. For an explanation of the Simulation
Control Area, see “Using the Simulation Control Area’ on page 4-46.

* Disablesthe Set up button and enablesthe Remove button

* Places the window in the active state and changes the state icon and title
bar accordingly

The Remove button is enabled only when the window isin the active state. When you
click on the Remove button, NightSim carries out the following actions:

* Displaysadialog verifying that NightSim should kill the processes running
on the scheduler. You may press Yes to kill the processes that are cur-
rently scheduled on the scheduler, No to remove the processes from the
scheduler but allow them to continue executing, or Cancel to abort the
action.

* Stopsthe simulationif it isrunning

¢ |f areal-time clock is being used as the timing source, and the scheduler is
running, stops the clock.

¢ Detaches the timing source from the scheduler or disables end-of-cycle
scheduling

* Removesall processesthat are currently scheduled on the scheduler from it
and either terminates them or allows them to continue executing in
accordance with the selections made in response to the dialog presented.
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Removes the scheduler from the system

Disables the Start, Stop, and Resume buttonsin the Simulation Control
Area

For an explanation of the Simulation Control Area, see“Using the Simula
tion Control Area’ on page 4-46

Enablesthe Set up button and disablesthe Remove button

Places the window in the inactive state and changes the state icon and title
bar accordingly

4-45
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Using the Simulation Control Area
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The Simulation Control Areais a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-9).

The Simulation Control Area allows you to start, stop, and resume a simulation. It con-

tains three push buttons that you use to perform these functions: the Start button, the
Stop button, and the Resume button.

Simulation

Running

Figure 4-23. Scheduler Window - Simulation Control Area

The Simulation Control Area aso contains an icon that indicates whether the smulation is
stopped or running.

When the simulation is stopped, NightSim dis-
plays a stop sign.

Stopped

When the simulation is running, NightSim dis-
plays a circle containing the word GO.

Running

The Start button is enabled only when the simulation is stopped. When you click on the
Start button, NightSim carries out the following actions:

¢ Attaches the timing source to the scheduler if not already attached or if the
timing source has been changed

¢ |f area-time clock is being used as the timing source, sets the clock period
in accordance with the value entered in the Clock period field in the
Scheduler Configuration Area (see “ Clock period” on page 4-26).

¢ Starts the ssimulation with the values of the minor cycle, major frame, and
overrun counts set to zero

The Stop button is enabled when the simulation is running. When you click on the Stop
button, NightSim stops the simulation. When the simulation is stopped, the timing source
is not detached from the scheduler, but the Timing source and Clock period fieldsin
the Scheduler Configuration Area of the Scheduler window are enabled (see pp. 4-24 and
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4-26, respectively, for information on these fields). You may wish to change the timing
source, and, if the timing source is a real-time clock, you may wish to change the clock
period.

NOTE

If you change the timing source, the previously specified timing
source is detached from the scheduler when you click on the
Start or Resume button to start or resume the simulation.

While the simulation is stopped, you may aso wish to change one or more of the parame-
ters with which you have scheduled a process on the scheduler.

Although you can also change the parameters with which a process has been scheduled
while the scheduler is running, it is not recommended that you do so. Rescheduling
requires processor time. As aresult, other processes that are currently scheduled on the
frequency-based scheduler may experience frame overruns. If you haveindicated as such,
the scheduler will halt on aframe overrun but can be resumed.

The Resume button is enabled when the simulation has been running but is currently
stopped. When you click on the Resume button, NightSim restarts the simulation with
the values of the minor cycle, major frame, and overrun counts the same as they were
when you stopped the simul ation.
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Using the Run Status Area
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The Run Status Areais a part of the Scheduler window (see “ Introduction to the Schedul er
Window” on page 4-9).

The Run Status Area shows the number of the current major Frame and the current minor
Cycle for the simulation running on the scheduler.

Run Status

Frame: 1238
Cycle: i
On Target: raptor =

Rate: |1D sec

Figure 4-24. Scheduler Window - Run Status Area

This area aso contains the following two configurable items:

On Target

This option menu allows you to select which target system supplies the frame num-
ber and minor cycle count. This allows you to see each target’s frame and cycle
counts and determine if the schedulers are out of sync. It also allows you to assign
the work of supplying this information to a target system that may not be as
time-critical as other systems.

Rate

This field allows you to specify the frequency with which the frame and cycle
counts in the Run Status Area are to be updated. Enter the number of seconds to
occur between updates. The minimum value that you may specify is .01 second; the
maximum is 100 seconds. The default valueis 1.0 second.
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Using the Monitor Window

This chapter describes the performance monitor and explains how to monitor FBS-
scheduled processes, a processor’s idle time, and unscheduled processes. It introduces the
components of NightSim’s Monitor window and describes the use of each component.

Understanding the Performance Monitor

The performance monitor is a mechanism that enables you to monitor FBS-scheduled pro-
cesses utilization of a CPU.

The performance monitor provides you with the ability to:

* Obtain performance monitor values by process or processor
e Start and stop performance monitoring by process

* Clear performance monitor values by processor

You also have the ahility to set the timing mode under which the performance monitor isto
run. You can select one of two modes: one that includes time spent servicing interruptsin
performance monitor timing values and one that excludes time spent servicing interrupts
from those values.

When the performance monitor timing mode is set to include interrupt time, a process's
user and system times will total the elapsed time that accrues when the process is the
currently running process. This elapsed time includes time spent servicing interrupts and
performing context switches. Time spent servicing interrupts is added to the process's
system time. Time spent switching to a new process is included in the new process's
system time.

When the performance monitor timing mode is set to exclude interrupt time, a process's
user and system times will total the time that accrues when the process is the currently
running process. This time excludes time spent servicing interrupts, but it includes time
spent performing context switches. Time spent switching to a new processisincluded in
the new process's system time.

What Values Are Monitored?

The performance monitor keeps track of the time that a process spends running from the
time that it is wakened by a frequency—based scheduler until it calls fbswait. Timeis
measured in microseconds. One instance of a process's being wakened by a scheduler is
referred to as an iteration or a cycle. Performance monitor values for FBS-scheduled
processes are reported both in terms of cycles, or iterations, and in terms of major frames.

51



NightSm RT User’s Guide

5-2

They reflect what has happened since the last time that performance monitor values were
cleared and performance monitoring was enabled.

When performance monitoring is enabled for an FBS-scheduled process, NightSim
maintains the following values for each process:

Process Parameters
Target

FPID

PID

Name

Priority

Starting Cycle

Period

CPU Mask

Interrupt Time Inclusion

General Statistics

Total iterations, cycles

Last time

Total time

Averagetime

Number of overruns

Percent of period used

The system on which this process is running

The process's unique frequency-based scheduler identifier
The process's process identification number

The process's name

The process's scheduling priority

The number of the first minor cycle in which the processis
to be wakened in each frame

The frequency with which the process is to be wakened in
each major frame

The process's CPU mask

Indicates whether time spent processing interrupts is
included in performance monitor timing values

The number of times that the process has been wakened by
the scheduler

The amount of time that the process has spent running from
the last time that it has been wakened by the scheduler until
it has called fbswait

The total amount of time that the process has spent running
inall cycles

The average amount of time that the process has spent
running in al cycles, or iterations. Thisvalueis obtained by
dividing the value reported in the Total Time column by the
value reported in the Iterations column.

The number of times that the process has caused consecu-
tive "soft" frame overruns, as well as the number of "hard"
frame overruns that the process has caused.

This value is maintained only if the timing source for the
frequency-based scheduler on which the process is
scheduled is areal-time clock. It is obtained by dividing the
value reported in the Average Time column by the amount
of time that is available to the process. The amount of time



Minimum Values

Minimum cycle time

Minimum cycle frame

Minimum cycle cycle

Minimum frame time

Minimum frame frame

Maximum Values

Maximum cycle time

Maximum cycle frame

Maximum cycle cycle

Maximum frame time

Maximum frame frame

Monitoring Idle Time

Using the Monitor Window

available to the processis calculated from its period and the
length of aclock cycle.

The least amount of time that the process has spent running
inacycle

The number of the major frame in which the minimum cycle
time has occurred

The number of the minor cycle in which the minimum cycle
time has occurred

The least amount of time that the process has spent running
during amajor frame

The number of the major frame in which the minimum
frame time has occurred

The greatest amount of time that the process has spent
running in acycle

The number of the major frame in which the maximum
cycle time has occurred

The number of the minor cycle in which the maximum cycle
time has occurred

The greatest amount of time that the process has spent
running during a major frame

The number of the major frame in which the maximum
frame time has occurred

The performance monitor provides you with the capability of monitoring a processor’s
idle time. Idle time refers to the time that the CPU is not busy. By monitoring a proces-
sor’sidle time, you can determine the amount of CPU time that is available to be allocated

to additional processes.

Procedures for monitoring idle time is described in “How Is Idle Time Monitored?”’

How Is Idle Time Monitored?

You can monitor a particular processor’s idle time if you add the process Zidle to a
frequency—based scheduler and schedule it on the desired processor. Y ou can aso moni-
tor idle time for a number of different processors by adding Zidle to a selected fre-
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guency-based scheduler more than once and scheduling it on a different processor each
time. Furthermore, you can add /Z 1dl e to more than one frequency—based scheduler.

NOTE

It isimportant to note that you can schedule Zidle on a particu-
lar processor for a particular target only once. Thisis a system-
wide restriction. Only one user per processor per target may
schedule Zidle.

To add Zidl e to afrequency—based scheduler, use the Process Scheduling Area of the
Scheduler window (see “Using the Process Scheduling Area” on page 4-27 for details).
For an explanation of the procedures for adding a program to a scheduler, refer to
Chapter 4, “Using the Scheduler Window.”

When you use NightSim to add Zidl e to afrequency—based scheduler, the only parame-
ter that you may specify is the CPU mask. The CPU mask for Zidle must specify only
one CPU. The default scheduling priority is zero. The starting base cycle is zero, and the
period isone. Zidle will be scheduled every minor cycle, starting with the first minor
cyclein each major frame.

You can view scheduling information for Zidle in the same way that you view it for
other FBS-scheduled processes—in the Process Scheduling Area of the Scheduler win-
dow (see “Using the Process Scheduling Ared’ on page 4-27 for details).

Monitoring Unscheduled Processes

54

The performance monitor provides you with the additional capability of monitoring the
performance of unscheduled processes. Unscheduled processes are those that are not
wakened by the scheduler and do not call fbswait; they are not scheduled to run at a
certain frequency. To be able to obtain performance monitor values for such processes,
you must first add them to a frequency—based scheduler and specify a starting base cycle
of zero and a period of zero. The other scheduling parameters that you must specify
include the process's scheduling priority and the CPU on which it isto be scheduled. Y ou
can optionally specify a decimal value to be passed to a process that is scheduled on a
frequency—based scheduler. The Halt FBS on frame overrun flag does not apply to
an unscheduled process (see “ Overrun” on page 4-33).

You can add unscheduled processes to a frequency—based scheduler by using the Process
Scheduling Area of the Scheduler window (see “Using the Process Scheduling Area” on
page 4-27 for details). For an explanation of the procedures for adding a program to a
scheduler, refer to Chapter 4, “Using the Scheduler Window.”

You can view scheduling information for unscheduled processes in the same way that you
view it for other FBS—scheduled processes—in the Process Scheduling Area of the Sched-
uler window (see “Using the Process Scheduling Area’ on page 4-27 for details).
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The performance monitor values that are maintained for unscheduled processes include
the following:

* Total time
You can obtain this value if you enable performance monitoring for the processes.

Procedures for enabling performance monitoring and retrieving performance monitor
values are described in detail in “Monitor” on page 5-8.
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Introduction to the Monitor Window
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The Monitor window allows you to start and stop performance monitoring on FBS-sched-
uled processes scheduled on one or more processors, clear performance monitor values for
all FBS-scheduled processes scheduled on one or more processors, and display perfor-
mance monitor values for selected FBS-scheduled processes.

Figure 5-1 is an example of a Monitor window.

raptor

E2® | NightSim  Monitor  Qutput View Tools Help
Target: raptor Scheduler Key: 2778 =§| . Frame: 4471 Cycle: 4

Target CPU Tter- Last Total Ava. Soft Ower  Per

Syzten FID  Program NEpe Biif ationz Time Time Time Ourhs  runs  Uszed

raptor ] Jidle G008505500555655 17601 873 16244300 522 - 0 92,30

19683 /fang/ jeffh/test/zim J e 10440 117 1231100 117 - 0 5,90

5 I— =

=

W Repetitive Query  Rate: |1D SEC Gluery MNow Resolution of Times 1 usec

Figure 5-1. Monitor Window

The Monitor window consists of the following components:

* Menu Bar (see“Using the Monitor Window Menu Bar” on page 5-7)

Status Area (see “Using the Status Ared” on page 5-21)

Output Area (see “Using the Output Area’ on page 5-23)

Output Control Area (see“Using the Output Control Area” on page 5-24)

Procedures for using each component of the Monitor window are described in the sections
that follow.
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Using the Monitor Window Menu Bar

NightSim

The Monitor window menu bar is a part of the Monitor window (see “Introduction to the
Monitor Window” on page 5-6).

The Monitor window menu bar provides access to the following menus:
* NightSim (see“NightSim” on page 5-7)
* Monitor (see“Monitor” on page 5-8)
¢ Qutput (see“Output” on page 5-13)
* View (see“View” on page 5-15)
* Tools (see“Tools’ on page 5-21)
* Help (see“Help” on page 5-21)

Each menu is described in the sections that follow.

The NightSim menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The NightSim menu on the Monitor window contains commands related to the global
operation of NightSim. Figure 5-2 presents this menu.

Create Scheduler Window

Create Monitar Window

Cuplicate Windaow
Close Window Ctrl+
Exit Ctrl+@Q

Figure 5-2. NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option allows you to create a new Scheduler window. If this option is selected
from a Monitor window which is associated with an existing scheduler, the new
Scheduler window is created as an active window and all information associated
with the Monitor window, including the target and scheduler key, is copied to this
new Scheduler window.
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Create Monitor Window

This option allows you to create a new Monitor window. The new window will not
be associated with a particular frequency-based scheduler.

Duplicate Window

This option allowsyou to create a new Monitor window with the same configuration
asthat of the Monitor window from which this option was selected. Note that if per-
formance monitor values are currently being logged to one or more files, the new
Monitor window will not be associated with those files.

Close Window
This option allows you to close the current Monitor window.

If performance monitor values are being logged to afile, NightSim requires that you
close thisfile before proceeding.

Exit

This option allows you to exit NightSim. If you have open Scheduler windows that
are untitled and contain unsaved changes, NightSim displays a warning dialog. In
each case, you may save the changes, close the window without saving the changes,
cancel the close operation, or display help related to the dialog. If you click on the
Yes button to save the changes, NightSim displays afile selection dialog.

If you have open a Scheduler window that is associated with a configuration file
name and contains unsaved changes, NightSim displays a warning dialog. If you
click on the Yes button, the changes are saved in the file associated with the win-
dow.

The warning dialogs are displayed for each window that contains unsaved changes.

If performance monitor values are being logged to one or more files, NightSim dis-
playsawarning dialog. You may confirm that you wish to stop logging and close the
file, continue to keep the window open, or display help related to the dialog.

If ascheduler is currently active, NightSim display a confirmation dialog that allows
you to exit and leave the scheduler active, or to cancel the exit action.

Monitor

The Monitor menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The Monitor menu contains general commands related to performance monitoring.
Figure 5-3 presents this menu.
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Select Active Scheduler..,

Associate Scheduler Window..,

Figure 5-3. Monitor Menu

Descriptions of the options on the Monitor menu follow.

Select Active Scheduler . ..

This option allows you to associate the current Monitor window with a frequency-
based scheduler active on a given target system. When you select this option, Night-
Sim displays Figure 4-6, “Select Active Scheduler Dialog,” (see p. 4-15 of
Chapter 4 for an explanation of this dial og).

This dialog provides alist of the active schedulers for the system designated by the
Target field. The Target defaultsto your local SBC and thelist contains the active
schedulers running on that particular system. For instance, Figure 4-6 lists the two
schedulers currently running on the target amber2.

You may change the Target either by using the drop-down list (which lists the tar-
getsin your cluster) or by typing the name of the target system into the text field
provided. Entering anitem in thisfield will populate the list with the active sched-
ulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may use the
Scheduler Key text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you select
from the list or enter a key, the selected scheduler must previously have been
configured, and you must have at least read permission for it; otherwise, NightSim
reports an error.

If you successfully select an existing scheduler, the Monitor window is associated
with that scheduler.

If performance monitor values are being logged to one or more files, NightSim asks
you if you wish to stop the logging and close the files. You may confirm that you
wish to stop logging and close thefile, continue to keep the window open, or display
help related to the dialog. |If the window from which you select Select Active
Scheduler . . . istheonly window that you have open, NightSim displays awarn-
ing dialog.
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Associate Scheduler Window . . .

This dialog box allows you to associate a Monitor window with an existing sched-
uler. Thedialog liststhe scheduler key and the target systems to which processes are
assigned for each Scheduler window in the current NightSim session. Select one of
these schedulers by clicking on it and pressing OK, or press Cancel to close the
dialog and leave the Monitor window unchanged.

Key Targets
2778 raptor
5 raptor
0K | Cancell Help |

L -

Figure 5-4. Select Associated Scheduler Window Dialog

Select Target and Key . ..

This dialog alows you to associate a Monitor window with a scheduler by specify-
ing the Target System where the scheduler residesand its Scheduler Key. The
scheduler need not already exist. If it does not exist but the scheduler is created in
this session of NightSim, the Monitor window will automatically start monitoring
that scheduler when the scheduler is created and started by NightSim.

bl Select Target System and Key

Target system |Eraptor i |

Scheduler Key: |5

‘ oK | Cancel | _Help |
= =

Figure 5-5. Select Target System and Key Dialog
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Enable/Disable Monitoring . . .

This option allows you to enable or disable performance monitoring for one or more
processes that are scheduled on the selected scheduler. By default, performance
monitoring is enabled for all FBS-scheduled processes.

When you select this option, NightSim displays the selection dialog that Figure 5-6
presents.

Target FID Program Mame CFPU Eias Enabled
raptor 4] Aidle @ococccccccccscsse Yes A
raptor 21652 Afangs jeffh /test /tutorial wave O, ... eerrrnnnns Yes J
£
PID Program Mame CPU hask
H H 01 2 3 456 7 8 9101112131415
I I i i ) o s o ] R S

Enablel Disablel Close | Help |

Figure 5-6. Enable/Disable Monitoring Dialog

Enable/Disable Monitoring List

Thislist contains all of the processes that are scheduled on the scheduler and indi-
cates whether or not performance monitoring is currently enabled for each process.
You may use the mouse to select the process or processes for which you wish to
enable or disable performance monitoring and then click on the Enable or Dis-
able button as desired.

You may also use a combination of the following items to specify those processes for
which you wish performance monitoring enabled or disabled:

FPID:

You may specify the unique frequency-based scheduler process identifier of a pro-
cess for which you wish performance monitoring enabled or disabled.

Program Name:
You may specify the name of the process for which you wish performance monitor-

ing enabled or disabled. Enter afull or relative pathname. The pathname must be
valid on the target system to which this process is assigned.

CPU Mask:

This panel of check buttons allows you to Enable or Disable performance moni-
toring for processes that are scheduled on the specified processor or processors.
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Click on one or more buttons, where the label 0 represents the first logical CPU, 1
represents the second, and so on. To select all CPUs on your system, click on the
All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, NightSim
reports an error. If more than one FBS-scheduled process with the specified identifier(s)
exists, all such processes are shown or hidden.

Enable

Enables performance monitoring for those processes either selected in the
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Disable

Disables performance monitoring for those processes either selected in the
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Include Interrupt Time

Thisitem allows you set the timing mode under which the performance monitor isto
run, indicating that time spent processing interrupts is to be included in perfor-
mance monitor timing values. Thisis a system-wide setting that affects all pro-
cesses on the target systems that have processes attached to the specified scheduler.

This status may be displayed by selecting the Interrupt Time Inclusion check-
box in the Custom Display dialog from the View menu (see Figure 5-10 on page
5-15). The Output Areain the Monitor window will then report this status for each
process (see “Using the Output Area’ on page 5-23 for related information).

Exclude Interrupt Time

Thisitem allows you to set the timing mode under which the performance monitor is
to run, indicating that time spent processing interrupts is to be excluded from per-
formance monitor timing values. Thisis a system-wide setting that affects al pro-
cesses on the target systems that have processes attached to the specified scheduler.

This status may be displayed by selecting the Interrupt Time Inclusion check-
box inthe Custom Display dialog from the View menu (see Figure 5-10 on page
5-15). The Output Area in the Monitor window will then report this status for each
process (see “Using the Output Area’ on page 5-23 for related information).

Clear Performance Values . ..

This option alows you to clear performance monitor values for all FBS-scheduled
processes on one or more processors. Note that values are cleared for selected CPUs
on al target systems that have processes attached to the specified scheduler.

When you select this option, NightSim displays the dialog that Figure 5-7 presents.



Output

Using the Monitor Window

Clear performance monitar values for CPL

012345678 3101112131415
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014 | Cancell Help |

Figure 5-7. Clear Performance Monitor Values Dialog

By default, All CPUs is selected, so that you may conveniently clear all perfor-
mance monitor values for al CPUs by simply pressing Enter or clicking OK.

You use the panel of check buttons to select the processor or processors for which
you wish to clear performance monitor values. Click on one or more buttons, where
the label O represents the first logical CPU, 1 represents the second, and so on. To
select all CPUs on your system, click on the All CPUs button. After selecting the
processor(s), you may apply your selection, cancel the operation, or display help
related to the dialog.

The Output menu appears on the Monitor window menu bar (see “Using the Monitor
Window Menu Bar” on page 5-7).

The Output menu controls where performance datais to be sent. Figure 5-8 presentsthis
menu.

W To Screen
To Text File...

Figure 5-8. Output Menu

A checkmark appears next to anitemif it isenabled. The two items can be enabled or dis-
abled independently. Descriptions of these options follow.

To Screen

This toggle button allows you to indicate whether or not performance monitoring
values are to be displayed in the Output Area of the Monitor window (see “Using
the Output Area” on page 5-23 for related information).

To Text File . ..

This option allows you to (1) specify the name of atext file in which you wish per-
formance monitor values to be saved and (2) specify the types of values to be saved.
When you select this option, NightSim displays afile selection dialog to specify the

5-13



NightSm RT User’s Guide

5-14

Fields to output. Summary Fields ﬂ

name of the text file.To select the file in which values are to be saved, use the direc-
tory text area, file mask area, list of directories, list of files, and file selection text
area as appropriate. To specify the types of values to be saved, use the Fields to
output option menu that Figure 5-9 presents.

finimum Fields
hecdmum Fields
All Fields

Custom...

Figure 5-9. Fields to Output Option Menu

Descriptions of the options contained in the Fields to output option menu follow.

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statistics.
Refer to “What Values Are Monitored?’ on page 5-1 for a complete descrip-
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and minimum values. Refer to “What Values Are Monitored?’ on page
5-1 for a complete description of al types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and maximum values. Refer to “What Values Are Monitored?’ on page
5-1 for a complete description of all types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. Refer
to “What Values Are Monitored?’ on page 5-1 for a complete description of
al types of performance monitor values.

Custom ...

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains.
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When you select this option, NightSim displays the dialog that Figure 5-10
presents.

Fields to display:

Process Params General Statistics tin. Cycle hlece. Cycle
W Target System R lteration Count I Time I Time
~ PID W Last Cycle Time I Frame I Frame
_| FPID W Total Time LI Cycle LI Cycle
W Program Mame W Awverage Time
I Priarity R Soft Ourn. Count tin. Frame hlax, Frame
I Starting Cycle W Cwerrun Count I Time I Time
I Period ¥ < of Period Used I Frame I Frame
# CPU Bias I Interrupt Time Inclusion

I

Figure 5-10. Custom Display Dialog Box

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to save. Click on one or more buttons as desired.
After you have selected the types of values that you wish to save, you may
apply the selections and close the Custom Display dialog box, cancel the
selections, or display help related to the dialog.

After selecting the file in which values are to be saved and specifying the
types of values to be saved, you may save the values in the selected file,
search for another file, cancel the operation, or display help related to the dia-

log.
View

The View menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7).

The View menu controls output to the Monitor window. Figure 5-11 presents this menu.

5-15



NightSm RT User’s Guide

Select Processes..

Lisplay Fields P
Sort By -
Then Sort By -

Fesolutian -

Figure 5-11. View Menu

Descriptions of the options on the View menu follow.

Select Processes. ..

This option alows you to specify the FBS-scheduled processes whose performance
monitor values will be reported.

Depending on the selection under the Output menu (see “Output” on page 5-13),
performance monitor values will be displayed in:

¢ the Output Area of the Monitor window if the “To Screen” option
is selected (see “Using the Output Area” on page 5-23 for more
information)

* atextfileif the“To Text File...” optionis selected

Note that performance monitoring must be enabled for a processin order for it to be
shown in the Monitor window. Performance monitoring is enabled for al processes
by default.

When you choose the Select Processes . . . option, NightSim displays the dia-
log in Figure 5-12:

Target FID Program Mame CFPU Eias Wizible
raptor 4] Aidle @ococccccccccscsse Yes A
raptor 21652 Afangs jeffh /test /tutorial wave O, ... eerrrnnnns Yes J
£
PID Program Mame CPU hask
v Y 01 2 3 456 7 8 9101112131415
| | i i ) o s o ] R S
Showl Hide | Closel Help |
I
oS

Figure 5-12. Select Processes to View Dialog
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Select Processes List

This list contains all of the processes that are scheduled on the scheduler and
indicates whether or not their performance values will be reported. You may
use the mouse to select the process or processes whose performance values
you wish to Show or Hide.

You may also use a combination of the following items to specify which processes
you wish to Show or Hide:

FPID:

You may specify the unique frequency-based scheduler processidentifier for a
process whose performance values you wish to Show or Hide.

Program Name:

You may specify the name of the process that you wish to Show or Hide.
Enter afull or relative pathname. The pathname must be valid on the target
system to which this processis assigned.

CPU Mask:

This panel of check buttons allows you to Show or Hide processeswhich are
scheduled on the specified processor or processors. Click on one or more but-
tons, where the label O represents the first logical CPU, 1 represents the sec-
ond, and so on. To select al CPUs on your system, click on the All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, Night-
Sim reports an error. If more than one FBS-scheduled process with the specified
identifier(s) exists, al such processes are shown or hidden.

Show

Reports the performance monitor values for those processes either selected in
the Select Processes List or specified using FPID, Program Name, or
CPU Mask .

Hide

Refrains from reporting the performance monitor values for those processes
either selected in the Select Processes List or specified using FPID,
Program Name, or CPU Mask .

Display Fields

This option allows you to specify the types of performance monitor values that are
to be displayed in the Output Area of the Monitor window (see “Using the Output
Area’ on page 5-23 for related information). When you select this option, NightSim
displays the tear-off menu that Figure 5-13 presents.
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summary Fields

fdinimum Fields
faximum Fields
All Fields

" Custom...

Figure 5-13. Display Fields Tear-Off Menu

Descriptions of the options contained in the Display Fields tear-off menu follow.

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statistics.
Refer to “What Values Are Monitored?’ on page 5-1 for a complete descrip-
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and minimum values. Refer to “What Values Are Monitored?’ on page
5-1 for a complete description of al types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and maximum values. Refer to “What Vaues Are Monitored?’ on page
5-1 for acomplete description of al types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. Refer
to “What Values Are Monitored?’ on page 5-1 for a complete description of
al types of performance monitor values.

Custom ...

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains.

When you select this option, NightSim displays the dialog that Figure 5-10
presents.

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to display. Click on one or more buttons as desired.
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After you have selected the types of values that you wish to display, you may
apply the selections and close the Custom Display dialog box, apply the
selections without closing the dialog box, cancel the selections, or display
help related to the dialog.

Sort By

This option allows you to select the primary sort key used in ordering the FBS
scheduled processes and associated performance monitor values. (Refer to “ Output”
on page 5-13 for information on specifying where these values are reported.)

When you select this option, NightSim displays the tear-off menu that Figure 5-14
presents.

(" Target System
PID
FPID
Program Mame
Priority
Starting Cycle
Period
CPU

Iteration Count

Last Cycle Time
Total Time
Average Time

Soft Gverrun Count
Qverrun Count

% of Period Used
hin. Cycle Time
tlin, Frame Time
e, Cycle Time
e, Frame Time

Figure 5-14. Sort By Tear-Off Menu

You specify the type of value to be used as the primary sort key by clicking on the
desired radio button. It is important to note that the first seven options are separated
from the others. The reason is that with the first seven options, the sort order must be
calculated only once. With the other options, the sort order must be recal culated
each time you query the values. As a result, the overhead associated with the first
seven optionsisfar less than that associated with the others.

The defaultis Target System.

Then Sort By

This option allows you to indicate the secondary sort key to be used in ordering the
FBS-scheduled processes and associated performance monitor values. (Refer to
“Output” on page 5-13 for information on specifying where these values are
reported.) The Sort By and Then Sort By options allow you to sort first on a
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value such as priority and then sort again within that grouping by a value such as
averagetime.

When you select this option, NightSim displays the tear-off menu that Figure 5-15
presents.

Mone

Target System
{7 PID

FPID

Program Mame
Priority
Starting Cycle
Period

CPU

Iteration Count

Last Cycle Time
Total Time
Average Time

Soft Gverrun Count
Qverrun Count

% of Period Used
hin. Cycle Time
tlin, Frame Time
e, Cycle Time
e, Frame Time

Figure 5-15. Then Sort By Tear-Off Menu

You specify the type of value to be used as the secondary sort key by clicking on the
desired radio button or you may choose the first option, None, to have no second-
ary sort key. It isimportant to note that the next eight options are separated from the
others. The reason is that with those eight options, the sort order must be calculated
only once. With the other options, the sort order must be recal culated each time you
guery the values. As aresult, the overhead associated with the eight optionsis far
less than that associated with the other options.

The default isFPID.

Resolution

This option allows you to control the precision with which NightSim reports the
performance monitor timing values. When you select this option, NightSim displays
the tear-off menu that Figure 5-16 presents.
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Help

Using the Monitor Window
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10 usec
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Figure 5-16. Resolution Options

You may specify the precision in microseconds, tens of microseconds, hundreds of
microseconds, milliseconds, or tens of milliseconds by clicking on the toggle button
and choosing the desired option.

NOTE

As the values of times increase in along-running simulation, the
resolution option value is automatically increased by NightSim in
order to avoid overflowing the display.

The Tools menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7) as well as on the Scheduler window menu bar (see “Using
the Scheduler Window Menu Bar” on page 4-11).

The Tools menu contains alist of other NightStar tools that can be launched directly from
NightSim.

See “Tools’ on page 4-19 for detailed information about this menu and each of itsitems.

The Help menu appears on the Monitor window menu bar (see “Using the Monitor Win-
dow Menu Bar” on page 5-7) as well as on the Scheduler window menu bar (see “Using
the Scheduler Window Menu Bar” on page 4-11).

The Help menu provides access to the on-line help system. See “ Getting Help” on page
3-3 for detailed information about this menu and each of itsitems.

Using the Status Area

The Status Areais a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-6).
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The Status Area displays information about the frequency-based scheduler with which this
Monitor window is associated.

Target: raptor Zcheduler Key: 2778 ﬂl Frame: 4471 Cycle: 4

Figure 5-17. Monitor Window - Status Area

It contains the following values:

Target

This field displays the target system on which the scheduler associated with this
Monitor window resides.

Together with the Scheduler Key, this Target system serves to identify the
scheduler to NightSim.

Scheduler Key

This field displays the numeric key for the scheduler with which this Monitor win-
dow is associated.

If the frequency-based scheduler with which the Monitor window is associated is an active
scheduler, the Status Area a so shows:

Frame

Current major frame of the associated frequency-based scheduler.

Cycle
Current minor cycle of the associated frequency-based scheduler.

The Status Area al'so contains two icons; one that indicates the current state of the sched-
uler and one that indicates the current state of the simulation.

@:@ When the scheduler is inactive, NightSim shows
an unplugged connection.

=@| When the scheduler is active, it shows a plugged

connection.
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When the simulation is stopped, NightSim dis-

plays a stop sign.
When the simulation is running, it displays a cir-
cle containing the word GO.

Figure 5-17 illustrates the Status Area for a Monitor window that is associated with an
active scheduler and arunning simulation.

Using the Output Area

The Output Areais a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-6).

The Output Area contains atextual display of performance monitor information.

Target. CPU Tter- Lazt Total Avg, Soft Ower  ZPer

System PID  Program Hame Biif atiohs Tine Tine Time Ovrns  runs  Used

raptor 0 Aidle 000B000060006000 17601 873 16244300 922 - 0 92,320

raptor 19683 /fang/ jeffh/test/sin 00CE000000000000 10440 117 1231100 117 = 0 5,90
=4

Figure 5-18. Monitor Window - Output Area

The Output Area allows you to view performance monitor values for selected FBS
scheduled processes. It contains a scrolling list of the processes that are currently
scheduled on the frequency-based scheduler with which the Monitor window is associated
and that have been selected for performance monitoring. You can use the horizontal and
vertical scroll bars to scroll the visible contents of the area. Although you cannot edit this
area of the Monitor window, you can use the mouse to select text in the area and pasteit in
another window—one in which an editor is running, for example.

NOTE

If the Priority, Period, or CPU Bias mask of a process are
changed while the scheduler is running, the Monitor window will
not reflect the updated values until the next Monitor window
update after the process runs again.
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For information on the commands that allow you to control the operation of the perfor-
mance monitor, refer to “Monitor” on page 5-8. For information on the commands that
alow you to control the information that is displayed in the Output Area, refer to “View”
on page 5-15.

t Control Area

The Output Control Areais a part of the Monitor window (see “Introduction to the Moni-
tor Window” on page 5-6).

The Output Control Area allows you to specify the frequency and precision with which
you wish performance monitor values to be updated. Note that the selections that you
make in the Output Control Area apply both to the values displayed in the Output Area of
the Monitor window (see “Using the Output Area” on page 5-23) and the values saved in a
file. See"Output” on page 5-13 for related information.

J| # Repetitive Query Rate:IELD Sec | Gluery Mow I Resolution of Times 1 usec H

Figure 5-19. Monitor Window - Output Control Area

The Output Control Area contains the following text field and controls:

Repetitive Query

This check button allows you to indicate that you wish NightSim to repeatedly
guery performance monitor values at arate that you specify in the Rate text field in
the Output Control Area. If this button is activated and the simulation on the fre-
guency-based scheduler associated with the Monitor window has not been started,
NightSim will query the target system (designated in the Target field of the Moni-
tor window) at the specified Rate to detect when the scheduler gets started.

Note that once the scheduler is active, NightSim must query every target system to
which processes have been assigned to obtain the complete set of performance data.
This may affect the performance of those target systems to some degree.

Rate

This field allows you to specify the frequency with which performance monitor
values are to be updated. Enter the number of seconds to occur between updates.
The minimum value that you may specify is 0.01 second and the maximum is 100
seconds. The default valueis 1.0 second.

Query Now

This push button allows you to query performance monitor values immediately.
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Resolution of Times

This displays the resolution of the times displayed by the performance monitor.
This resolution is controlled by the Resolution item in the View menu. See
“View” on page 5-15 for more information.
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License Keys

A
NightStar Licensing

NightStar RT uses the NightStar License Manager (NSLM) to control access to the Night-
Star RT tools.

Licenseinstallation requires alicence key provided by Concurrent. The NightStar RT tools
request a licence (see “License Requests’ on page A-2) from alicense server (see
“License Server” on page A-2).

Two license modes are available, fixed and floating, depending on which product option
you purchased. Fixed licenses can only be served to NightStar RT users from thelocal sys-
tem. Floating licenses may be served to any NightStar RT user on any system on a net-
work.

Tools are licensed per system, per concurrent user. A single license is shared among any or
al of the NightStar RT tools for a particular user on a particular system. The intent is to
allow n developers to fully utilize all the tools at the same time while only requiring n
licenses. When operating the tools in remote mode, where atool is launched on alocal
system but is interacting with a remote system, licenses are required only from the host
system.

You can obtain alicense report which lists all licenses installed on the local system, cur-
rent usage, and expiration date for demo licenses (see “License Reports’ on page A-3).

The default configuration includes a strict firewall which interferes with floating licenses.
See “Firewall Configuration for Floating Licenses” on page A-3 for information on han-
dling such configurations.

See “License Support” on page A-4 for information on contacting Concurrent for addi-
tional assistance with licensing issues.

Licenses are granted to specific systems to be served to either local or remote clients,
depending on the license model, fixed or floating.

License installation requires a license key provided by Concurrent. To obtain a license
key, you must provide your system identification code. The system identification code is
generated by the nsIm_admin utility:

nsIm_admin --code

System identification codes are dependent on system configurations. Reinstalling Linux
on a system or replacing network devices may require you to obtain new license keys.

To obtain alicense key, use the following URL :
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http://www.ccur.com/NightStar RTK eys

Provide the requested information, including the system identification code. Your license
key will beimmediately emailed to you.

Install the license key using the following command:
nsim_admin --instal 1000000 X00X-X00X-XXXX

Where Xx00-X0x-Xo0-xxaxk-Xxxx i s the key included in the license acknowledgment email.

License Requests

License Serve

A-2

By default, the NightStar RT tools request a license from the local system. If no licenses
are available, they broadcast a license request on the local subnet associated with the sys-
tem’s hostname.

You can control the license requests for an entire system using the Zetc/nsIm.config
configuration file.

By default, the /etc/nsIm.config file contains aline similar to the following:
:server @default

The argument @default may be changed to a colon-separated list of system names, system
| P addresses, or broadcast | P addresses. Licenses will be requested from each of the enti-
tiesfound in thelist, until alicenseis granted or al entriesin the list are exhausted.

For example, the following setting prevents broadcast requests for licenses, by only speci-
fying the local system:

:server localhost

The following setting requests a license from server1, then server2, and then a
broadcast request if those fail to serve alicense:

:server serverl:server2:192.168.1.0

Similarly, you can control the license requests for individual invocations of the tools using
the NSLM_SERVER environment variable. If set, it must contain a colon-separated list of
system names, system | P addresses, or broadcast |P addresses as described above. Use of
the NSLM_SERVER environment variable takes precedence over settings defined in
/etc/nsim.config.

r

The NSLM license server isautomatically installed and configured to run when you install
NightStar RT.


http://www.ccur.com/NightStarRTKeys

NightStar Licensing

The nsIm service isautomatically activated for run levels 2, 3, 4, and 5. You can check on
these settings by issuing the following command:

/sbin/chkconfig --list nslim
In rare instances, you may need to restart the license server viathe following command:
/sbin/service nslm restart

See nsIm(1) for more information.

License Reports

A license report can be obtained using the nsIm_admin utility.
nsim_admin --list

listsall licensesinstalled on the local system, current usage, and expiration date (for demo
licenses). Use of the -—verbose option aso listsindividual clientsto which licenses are
currently granted.

Adding the -—broadcast option will list thisinformation for all servers that respond to
abroadcast request on the local subnet associated with the system’s hostname.

SeenslIm_admin(1) for more options and information.

Firewall Configuration for Floating Licenses

RedHawk does not support afirewall configuration by default, because i ptables support is
disabled. However, it is possible to build a custom kernel with iptables support enabled. If
that is done, and floating licenses are used, the iptables firewall rules must be configured
to alow the license requests and responses to pass.

If the system with iptables support and firewall rulesis serving licenses, then the firewall
rules must be arranged to allow license requests on UDP port 25517 and TCP port 25517
from any systems that will make license requests. For example, in asimple firewall, rules
like the following, inserted before any DROP or REJECT rules, might work:

iptables -A INPUT -p udp -m udp -s subnet/mask --dport 25517 -j ACCEPT
iptables -A INPUT -p tcp -m tcp -s subnet/mask --dport 25517 -j ACCEPT

If the system with iptables support and firewall rulesis running NightStar RT tools and
receiving floating licenses, then the firewall rules must be arranged to allow license
responses on UDP port 25517 from any system serving licenses. For example, in asimple
firewall, ruleslike the following, inserted before any DROP or REJECT rules, might work:

iptables -A INPUT -p udp -m udp -s subnet/mask --sport 25517 -j ACCEPT
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For additional aid with licensing issues, contact the Concurrent Software Support Center
at our toll free number 1-800-245-6453. For calls outside the continental United States, the
number is 1-954-283-1822. The Software Support Center operates Monday through Fri-
day from 8 am. to 5 p.m., Eastern Standard Time.

You may also submit a request for assistance at any time by using the Concurrent Com-
puter Corporation web site at http://www.ccur.com/isd_support_contact.asp or by send-
ing an email to support@ccur.com.


http://www.ccur.com/isd_support_contact.asp
mailto:support@ccur.com

B
Kernel Dependencies

Concurrent’s RedHawk kernel provides features and performance gains that are critical
for the full operation of the NightStar RT tools.

The NightStar RT tools can operate in a host-only mode on Red Hat systems without Con-
current’s RedHawk kernel, cross-targeting to RedHawk systems. Additionally, the Night-
Star RT tools can function on Red Hat systems without the RedHawk kernel, but will lack
the numerous advantages afforded by running with it.

The following sections describe the additional functionality and capabilities of the Night-
Star RT tools when running Concurrent’s RedHawk kernel.

Advantages for NightView

The following advantages are afforded NightView when Concurrent’s RedHawk kernel is
running:

* Application speed conditions
Provides “ execution-speed” patches, conditions, and ignore counts.
* Hot operations

Users of NightView gain the ability to read and write to a particular process without
having to stop it. Thus, al eventpoints can be applied and modified during applica-
tion program execution without stopping the process. User variables also can be
read and modified without stopping the process.

¢ Signa handling
Allows NightView to pass signals directly to a particular process, avoiding context
switching.
NOTE

NightView may not operate at all on older versions of Red Hat
without the RedHawk kernel.
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Advantages fo

r NightTrace

The following advantage is afforded NightTrace when Concurrent’s RedHawk tracing
kernel isrunning:

¢ Kernel tracing

Users of NightTrace gain the ability to obtain kernel trace data and combine that
with user trace data. Kernel tracing is an incredibly powerful feature that not only
provides insight into the operating system kernel but also provides useful informa-
tion relating to the execution of user applications.

The RedHawk kernel is provided in three flavors:
* Tracing
* Debug
* Plain

The Tracing and Debug flavors provide the features required for NightTrace kernel trac-
ing. These kernels can be selected at boot-time from the boot-loader menu.

Advantages for NightProbe

B-2

The following advantages are afforded NightProbe when Concurrent’s RedHawk kernel is
running:

* Minimal intrusion

Allows NightProbe to read and write variables without stopping the process for each
sample or write operation.

¢ Sampling performance

Allows NightProbe to use direct memory fetches for data sampling (as opposed to
programmed 1/0) which isimportant for high-rate data acquisition.

¢ Concurrent debugging/probing

Allows NightProbe to probe programs already under the control of a debugger or
another NightProbe session.

* PCI Device probing

Allows NightProbe to probe PCI device memory via the Base Address Register
(BAR) file system.
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Advantages for NightTune

The following advantage is afforded NightTune when Concurrent’s RedHawk kernel is
running:

* Context switch rate

Allows NightTune user to display the context switch counts per CPU instead of for
the overall system.

* CPU shielding

Individual CPUs can be shielded from interrupts and processes allowing CPUs to be
dedicated solely to specific interrupts and processes that are bound to the CPU.

* CPU sibling interference

Individual CPUs can be marked down to avoid interfering with hyperthreaded sib-
ling CPUs and dual-core sibling CPUs. Hyperthreaded CPUs share all the resources
of their sibling CPU. Dual-core CPUs share the CPU cache and a path to memory
with their sibling CPU.

Advantages for NightSim

The following advantage is afforded NightSim when Concurrent’s RedHawk kernel is
running:

¢ Scheduling target

Allows NightSim to schedule processes on the system via Concurrent’s Fre-
guency-Based Scheduler.
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Configuration Files

NightSim allows the user to save the configuration to a file with the following format:

Scheduler <key> {
cycles <n>;

tasks total

<n>;

tasks per cycle <n>;
permissions owner=<perms>;
distribution <dist_kind>;

timing source {

}

host ''<name>";

EOC ;

clock "<name>";

eti '"'<name>"';
other "<name>";
clock duration <n>;
clock count <n>;

process '<program_name>'' on

NightView <boolean> ;
xterm <boolean> ;

dir "<name>" ;

input <style> ;
infile "name" ;
output <style> ;
outfile "<name>" ;
privilege "<privlist>" ;
policy <p>;

priority <n>;
parameter <n>;

soft overruns <n>;
cpu <mask>;

start cycle <n>;
period <n>;

The values for

//
//
//
//
//

//
//
//
//
//
//
//

cycles per frame

total number of tasks allowed in scheduler
optional, defaults to total tasks
permissions, see below

distribution kind, see below

timing-host name

it end-of-cycle timing

if rtc, simple name of clock

if eti, simple name of eti

full pathname of device

if rtc, clock duration in microseconds
if rtc, ticks per minor cycle.

"<target_name>" {

//
//
//
//
//
//
//
//
//
//

schedule under NightView, {True | False}

run under an xterm(l), {True | False}

full pathname of working directory on target
input source, {File | Standard}

full pathname of input file

output destination, {File | Standard}

full pathname of output file

working privileges, see below

scheduling policy, p={R | O | P}
scheduling priority

// program parameter. if absent, -1
// soft overrun limit. if absent, no limit
// cpu bias mask, see below
// starting cycle
// period
NOTE
<name>, <program_name>,

<target_name>, and <privlist> must be enclosed in dou-

ble quotes (**)

The <perms> specification is a sequence of one or more of the following:

owner=<permspec>
group=<permspec>
other=<permspec>

where <permspec> iseither 'r’,'w’, or 'rw'.

The <dist_kind> specification is one of the following values:

“None”

target names must match the timing-host name

“Closely Coupled” targets must be in the same cluster as timing-host
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“RCIM Coupled” targets are on the same RCIM chain as timing-host.
The <boollean> specifications should have a simple boolean keyword:
True the feature is enabled
False the feature is disabled
The <style> specifications should have one of the following values:

File input/output should be redirected from/to a file on the
target system. A name must be provided.

Standard I/0O should be performed to/from standard 1/O streams,
Standard Input, or Standard Error.

NOTE

If both xterm and NightView boolean parameters are Fal se,
then the <style> specifications for input and output must
both be File.

The <privlist> specification should contain a comma-separated list of simple
privilege names. For example:

“owner ,dev,rtime"
See intro(2) for more information on privileges.

The <mask> specification can be a comma-separated list of mask specifiers. Each
specifier can be a CPU number (specified as an integer), arange of CPU numbersin
the form <n>-<m>, or the keyword active, indicating al active CPUs on the sys-
tem.
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Configuration File Example

The following is an example of a configuration file.

Scheduler 2778 {
cycles 4;
tasks total 4;
tasks per cycle 4;
permissions owner=rw;
distribution none;

timing source {
host ""localhost™;
clock "/dev/rcim/rtc2";
clock duration 10;
clock count 10;

}

process "./wave"
on "localhost” {
NightView False ;
xterm False ;
dir "." ;
input File ;
infile "/dev/null” ;
output File ;
outfile "/dev/null™” ;

priority 1;
parameter -1;
soft overruns 0;
cpu 0;
start cycle 0;
period 1;

¥

process "/idle"
on "localhost" {

NightView False ;
xterm False ;
dir /" ;
input File ;
infile "/dev/null” ;
output File ;

outfile ""/dev/null" ;

policy F;
priority 99;
parameter O;
soft overruns 0;
cpu 0;

start cycle 0;
period 1;
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D
Resources

This appendix details the X resources, NightStar resources in NightSim.

The following X resources are available for configuring the behavior of NightSim:
*defaultClockRes

Specifies the default resolution in microseconds that is to be used when configuring
areal-time clock. Permissible values are 1, 10, 100, 1000, and 10000. The default
valueis10.

*defaultPermissions

Specifies the default access permissions to be used when creating a new scheduler.
The value is an octal number in the same format used by chmod(1). The default
value is 600.

*defaultUpdateRate

Specifies the default rate in seconds that is to be used for updating the run status
fieldsin the Scheduler window and taking repetitive queries in the Monitor window.
Minimum valueis 0.01 second; maximum value is 100 seconds; default value is 1.0
second.

*defaultMonitorRes

Specifies the default resolution in microseconds of time-based fields in the Monitor
window. Permissible valuesare 1, 10, 100, 1000, and 10000; the default valueis 1.

*displayTitlel - *displayTitle9
*displayFieldsl - *displayFields9

These resources are used to specify the predefined sets of performance monitor

fields. Up to 9 sets of fields can be defined. The displayTitlen resourceisa
string that defines a name for field set n, and the displayFieldsnresourceisa
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list of four-letter codes that specify the fields to be displayed. The codes are as fol-

lows:
targ Target system
fpid FPID of the process
spid system PID of the process
name program name
prio program priority
stcy starting cycle
peri period
cpum CPU bias
itrc iteration count
Icyt last cycletime
tott total time
avgt average cycletime
sorc soft overrun count
ovrc overrun count
prcn percent of period used
mnct minimum cycletime
mncf minimum cycle frame
mncc minimum cycle cycle
mnft minimum frame time
mnTf minimum frame frame
mxct maximum cycletime
mxcF maximum cycle frame
mxcc maximum cycle cycle
mxFt maximum frame time
mxFF maximum frame frame
intr inclusion/exclusion of interrupt time

As an example, the following is the default for the first field set:

*displayTitlel: Summary Fields
*displayFieldsl: targ fpid name cpum itrc lcyt tott
avgt sorc ovrc prcn

*offline

Specifies whether new Scheduler windows should be initially Off-Line (True) or
On-Line (False). See“On-Line/Off-Line Operation” on page 4-6 for more infor-
mation.

*expert

Specifies whether the user is running in expert mode (True or False). The default
valueisFalse.

*serverStartTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Night-
Sim server to start up on atarget system. If the server does not start successfully
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within this time period, but no error is received, NightSim aborts the operation and
displays an error message.

The default value is 15 seconds. You may need to specify alonger time for slow or
heavily-loaded networks or target systems.

*serverMessageTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Night-
Sim server to respond to a message. |If the server does not respond within this
period, NightSim will assume that the server has terminated or that the remote target
isinoperative. NightSim will then abort the operation and display an error message.

The default value is 20 seconds. You may need to specify alonger time for slow or
heavily-loaded networks or target systems.

*extendedResponseTimeout

Specifies the maximum length of time (in seconds) that NightSim should allow for
the NightSim server to respond with alonger response to a message. For example,
the length of time NightSim should wait for the NightSim server to read a remote
directory and return the names of al the files contained within.

If the server does not respond within this time period, NightSim will assume that the
server has terminated or that the remote target is inoperative. NightSim will then
abort the operation and display an error message.

The default value is 90 seconds. You may need to specify alonger time for slow or
heavily-loaded networks or target systems.

NightStar Resources

You may control NightSim's appearance using the NightStar Font Resources and
NightStar Color Resources. In most cases, however, the default values for the following
resources should be used.

NightStar Font Resources

This section describes the specia font resources available for NightStar tools. In addition
to these resources, NightStar tools specify an overall default font that is used for most of
the textual display. NightStar tools use proportional-width fonts except in areas that
depend on text alignment; in these instances a fixed-width font is important for
readability. If you decide to change fonts, make sure that you choose another fixed-width
font for the font resources that have fixed in their names.

NightStar font resources include:
*smal IFontList

Used for areas that require a smaller font.
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*infoFontList

Used for areas that display informational messages, warnings, errors.
*FixedFontList

Used for areas that depend on text alignment.
*smal IFixedFontList

Used for areas that depend on text alignment but require a smaller font.

The Zusr/1ib/X11/app-defaul ts/Nsim resource file specifies the font values for
NightSim.

NightStar Color Resources

D-4

This section describes the special color resources available for NightStar tools. In
addition to these resources, NightStar tools specify an overall default color that is used
for most of the window areas. NightStar tools use the same color scheme to indicate that
they are part of the sametool set and to provide cues about the usage of different areasin
the windows. Each NightStar tool uses a unique color for its menu bars.

The following NightStar color application resources are defined:

*outputBackground
*outputForeground

Used for the background and foreground colorsin output-only areas.

*inputBackground
*inputForeground

Used for the background and foreground colors in areas that accept user input.

The Zusr/lib/X11/app-defaults/Nsim-color resource file specifies the color
values for NightSim.



Glossary

active scheduler window

A Scheduler window that is associated with a scheduler that exists on the system.

end—of—cycle scheduling

expert mode

FBS

FPID

frame overrun

A form of frequency—based scheduling in which scheduling is triggered when the last
process that is scheduled to execute in the current minor cycle of the current major frame
completes its processing.

A mode specified by setting the expert X resource to True, allowing the user to see
more detailed information about the current FBSin the Scheduler window.

Frequency-based scheduler.

A unique frequency—based scheduler processidentifier that is returned when a programis
scheduled on a frequency—based scheduler.

The condition that occurs when an FBS-scheduled process does not finish its processing
beforeit is scheduled to run again.

frequency-based scheduler

host system

idle time

A high resolution task synchronization mechanism that enables processes to run at user—
specified frequencies.

A system designated by a host name. A host may be a stand-alone computer system or a
node in a network of computer system connected by ethernet. See NightSm host, timing
host, target system.

Time during which the CPU is not busy.
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inactive scheduler window

iteration

KoalaTalk

last time

major frame

maximum cycle cycle

maximum cycle frame

maximum cycle time

maximum frame frame

maximum frame time

Glossary-2

A Scheduler window that is not associated with an existing scheduler.

Oneinstance of a process's being wakened by a frequency—based scheduler.

The inter-tool communication mechanism used by NightSim to exchange messages
among its components. It is provided with the X Window System.

A value returned by the performance monitor indicating the amount of time that an FBS-
scheduled process has spent running from the last time that it has been wakened by the
scheduler until it has called fhswai t.

One pass through all of the minor cycles with which a frequency—based scheduler is
configured. A major frame has associated with it a duration, which is obtained by
multiplying the duration of aminor cycle by the number of minor cycles per magjor frame.

A value returned by the performance monitor indicating the number of the minor cyclein
which the maximum cycle time has occurred.

A value returned by the performance monitor indicating the number of the major framein
which the maximum cycle time has occurred.

A value returned by the performance monitor indicating the greatest amount of time that
an FBS-scheduled process has spent running in acycle.

A value returned by the performance monitor indicating the number of the major framein
which the maximum frame time has occurred.

A value returned by the performance monitor indicating the greatest amount of time that
an FBS—-scheduled process has spent running during a major frame.



minimum cycle cycle

minimum cycle frame

minimum cycle time

minimum frame frame

minimum frame time

minor cycle

NightSim host

NightSim server

number of overruns

Glossary

A value returned by the performance monitor indicating the number of the minor cycle in
which the minimum cycle time has occurred.

A value returned by the performance monitor indicating the number of the major framein
which the minimum cycle time has occurred.

A value returned by the performance monitor indicating the least amount of time that an
FBS-scheduled process has spent running in acycle.

A value returned by the performance monitor indicating the number of the major framein
which the minimum frame time has occurred.

A value returned by the performance monitor indicating the least amount of time that an
FBS-scheduled process has spent running during a major frame.

The smallest unit of frequency maintained by afrequency—based scheduler. A minor cycle
has associated with it a duration, which is the time that elapses between interrupts
generated by the timing source that is attached to the scheduler. If the timing sourceis a
real—-time clock, the minor cycle duration is defined by specifying the number of clock
counts per minor cycle and the number of microseconds per clock count.

The system from which NightSim was invoked.

The NightSim server is a program that executes on atarget system and performs system-
level actions on behalf of NightSim. Whenever NightSim needs to perform an operation
on atarget system, such as creating an FBS, scheduling a program on an FBS, or starting
or stopping an FBS, NightSim makes a request of the NightSim server on that target sys-
tem. NightSim automatically takes care of starting up a NightSim server on atarget sys-
tem when needed.

A value returned by the performance monitor indicating the number of times that an FBS-
scheduled process has caused a soft or hard frame overrun.
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performance monitor

period

privilege

A mechanism that makes it possible to monitor use of the CPU by processes that are
scheduled on a frequency—based scheduler.

A frequency—based scheduler scheduling parameter that specifies the frequency with
which a specified program is to be wakened in each major frame. A period of one indi-
cates that the program is to be wakened every minor cycle; aperiod of two indicates that it
is to be wakened once every two minor cycles; and so on.

A mechanism through which processes are allowed to perform sensitive operations or
override system restrictions.

process dispatch latency

RCIM

scheduler key

server

soft overrun

starting base cycle

Glossary-4

The time that elapses from the occurrence of an external event, which is signified by an
interrupt, until the process that is waiting for that external event executes its first
instruction in user mode.

Real-Time Clocks and Interrupt Module - an optional hardware module which provides
both real-time clocks and edge-triggered interrupt pins for the host to which it is attached,
allowing those devices to be used as timing and interrupt sources for that host. RCIMs
may be connected, and therefore synchronized, via RCIM cables. RCIM real-time clocks
and edge-triggered interrupts may be used locally or as distributed timing devices.

A user—supplied numeric identifier for a frequency—based scheduler.

See NightSm server.

Soft overruns are atype of frame overrun which give the scheduled process a chance to
recover and return to synchronization. When scheduling a process, you can specify a con-
secutive soft overrun limit count that this process will tolerate and have processed as soft
overruns by the kernel. Soft overruns are catastrophic failures only if the process reaches
its limit on the number of soft overruns tolerated. This soft overrun limit defaults to O for
each process.

A frequency—based scheduler scheduling parameter that specifies the first minor cyclein
which an FBS-scheduled processis to be wakened in each major frame.



target system

timing host

timing mode

total iterations

total time

unscheduled process

Glossary

Any system on which processes will be scheduled.

The system on which the timing device physically resides.

The mode under which the performance monitor runs. It specifies whether time spent
servicing interrupts is to be included in or excluded from performance monitor timing
values.

A value returned by the performance monitor indicating the number of times that an FBS-
scheduled process has been wakened by the scheduler.

A value returned by the performance monitor indicating the total amount of time that an
FBS-scheduled process has spent running in al cycles.

A process that is not wakened by the frequency—based scheduler and does not call
fbswait; it is not scheduled to run at a certain frequency.
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